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Before reading this manual

This Operation Manual provides instructions for using Remote Administration System (referred to as IDIS Center
hereinafter), which is a remote control software for network cameras, network video servers, network video recorders
(NVR) and digital video recorders (DVR).

The IDIS Center System described in this Operation Manual refers to the PC running IDIS Center program and
Devices refer to network cameras, network video servers, network video recorders (NVR) and digital video recorders
(DVR).

Copyright

© 2025 IDIS Co., Ltd.
IDIS Co., Ltd. reserves all rights concerning this operation manual.

Use or duplication of this operation manual in part or whole without the prior consent of IDIS Co., Ltd. is strictly
prohibited.

Contents of this operation manual are subject to change without prior notice for reasons such as functionality
enhancements.

Registered Trademarks

IDIS is a registered trademark of IDIS Co., Ltd.
Other company and product names are registered trademarks of their respective owners.

The information in this manual is believed to be accurate as of the date of publication even though explanations of some
functions may not be included. We are not responsible for any problems resulting from the use thereof. The information
contained herein is subject to change without notice. Revisions or new editions to this publication may be issued to incorporate
such changes.

The software included in this product contains some Open Sources. You may obtain the corresponding source code which we
have to distribute according to the license policy. Go to Client Menu - About page for more information. This product includes
software developed by the University of California, Berkeley and its contributors, and software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/). Also, this product includes cryptographic software written by Eric
Young (eay@cryptsoft.com), and software written by Tim Hudson (tjh@cryptsoft.com).
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Part 1 - Introduction

IDIS Center is software for monitoring live videos and playing recorded videos acquired from compatible devices. It
provides the following features.

« Remote surveillance of live videos and remote playback of video recordings
« Real-time notification of detected events and remote monitoring of event videos
- Panic recording of live videos and playback of panic recordings

+ Registration of up to 2,048 devices

« Remote software upgrade and remote system configuration

« Displays device's system logs

+ Monitoring live video map

+ H.264, MPEG-4, M-JPEG restoration algorithm support

« SSL support for security

- Authority settings by user groups for security

« Intuitive and user-oriented GUI

« Operation in a low bandwidth environment

The software included in this product contains some Open Sources. You may obtain the corresponding source code which
we have to distribute according to the license policy. Go to Client Menu - About page for more information. This product

includes software developed by the University of California, Berkeley and its contributors, and software developed by

the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Also, this product includes cryptographic

software written by Eric Young (eay@cryptsoft.com), and software written by Tim Hudson (tjh@cryptsoft.com).
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Accessories

« Operation Manual

System Requirements

Recommended

Minimum

(0} Microsoft” Windows™ 11, Microsoft” Windows" 10
64-bit (Home/Pro), Windows Server 2016 or higher

Microsoft’ Windows® 10 (Home/Pro)

CPU | Intel’ Core™ i7-12700K 3.6GHz or better

Intel” Core™ i3-2100 or better

RAM | 16GB or more

2GB or more

VGA | NVIDIA GeForce GTX1060 or Quadro P2000 or
better (1920x1080 or 2560x1440, 60Hz)

NVIDIA GeForce GT710 (1280x1024, 60Hz) or Intel’
HD Graphic 530 or higher

HDD | 8GB or more of available space SSD(Solid State
Drive)

4GB or more of available space

LAN | Gigabit Ethernet or better

100 Mbps Ethernet

IDIS Center program runs on 32-bit and 64-bit OS.



Installation

Prior to installing the software, click on to the Windows
Start menu, open Control Panel, click on Power
Management, and set options for Turn off monitor and
Turn off hard disks as Never.

Download the software from the IDIS website(www.
idisglobal.com).

Browse to the Setup folder in the downloaded file
andrun setup.exe.

On Microsoft” Windows® Vista or better,
User Account Control window may appears.

Click Allow and follow the instructions in

the installation window to proceed with the

installation.

Select a desired language.

& Language Selector

When the installation window appears, click Next.

Select an installation path for the program, and click
Next.

Part 2 - Installation

When the install confirmation window appears, click

Next.

NET Framework and Visual C++ Runtime Libraries
will be installed automatically, and it may take a
few minutes. If NET Framework and Visual C++
Runtime Libraries are already installed on the
system, this step will be skipped automatically.
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When the Installation Complete window appears, Uninsta"ation
click Close and finish the installation.

Exit IDIS Center program if it is running.

« The program may not be uninstalled correctly
if you attempt to uninstall the software while
running.
- If the installation folder is deleted by the user
without using the Uninstallation Wizard, you
will not be able to properly uninstall or reinstall

the software. Please be sure to follow the
uninstallation steps in this manual.

Select IDIS Center in Windows Start Menu and click
Uninstall IDIS Center.
This program does not have a password set by
default. Please assign a password. Without setting a

. . When the uninstall confirmation window appears,
password, you will not be able to log in.

click OK.

A data delete confirmation window will appear. To
delete all the data stored on the system, including
panic recordings and existing settings, click Remove
all. If you do not wish to delete the data, click Do
not remove.

Deleted data cannot be recovered.

Click Close to finish uninstallation.

10



Part 3 - Getting Started

Start Program

When IDIS Center software is installed, IDIS Center and
IDIS Center Run as administrator shortcut icons will
be created on the desktop. Run IDIS Center program by
double-clicking on IDIS Center or IDIS Center Run as
administrator shortcut icon. If a removable eSATA HDD
or SD (SDHC) memory card are connected to the IDIS
Center system, you must double-click on IDIS Center
Run as administrator. Double-click the IDIS Center for
iHDP shortcut icon to use iHDP exclusively in an easier
way.

Run as administrator

If not using an administrator account to run IDIS Center,
the device's detachable HDD, eSATA HDD, and/or SD
(SDHC) memory card will not be recognized. In this case,
you will need to launch the program by double-clicking
on the Run as administrator icon.

Once the program launches, enter the administrator
information.

- User ID: Choose an administrator account or enter it
manually.

« Password: Enter the account password.

« No Password: Check if there is no password for the
account.

- Save Account Information: Saves the current
account info for automatic login.

Login limitations may exist depending on the OS
¢ specifications or the user account settings of the
computer running the IDIS Center program.

Login

This program does not have a password set by default.
Leaving the admin account unassigned with a password
poses a security risk. Please assign a Password at your
earliest convenience.

Once the program is running, you must login.
Enter a User ID and Password.
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+ Remember my ID on this computer: Remembers the
ID used to login.

- Restore last Live sessions: Restores the previous Live
session on the current Live panel (Not supported for
Load user specific layout).

I

12

Default User ID is "admin" without a password.
You can change User ID and Password in the User
menu.

For more details, refer to User Management on
page 34.

Device Registration

To use the functions provided by IDIS Center, you must
first register a device and add the device to a device

group.

Select System > IDIS Center Setup > Device in the
menu at the top of the screen.



On the Site panel, click on All Devices, then click on
the 4 button at the bottom of the Site List panel on
the right. A Device Scan window will appear on the

screen.

>
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- Scan Mode: After selecting a scan mode, click
on Start Scan button and the scan results will be
displayed on the list. If the IP address range of the
device is different from the one of IDIS Center System,
the IP address of the device will be considered invalid
by IDIS Center software. In this case, the device's IP
address must be changed before registering it to the
system.

- Auto Scan (LAN): Shows the list of devices within
the LAN. (DVR is not supported.)

- IP Address: Enter the device's IP address. When
registering multiple devices, you can enter a range
of IP addresses to scan for multiple devices at once.
When setting up network connections on the
device, it is recommended that you disable DHCP. If
DHCP is enabled, changes in the WAN connection
may cause the connection to the device to fail.
When manually scanning with an IP, the device
name is displayed as <no name> before its user
authentication.

- FEN: If the device uses FEN, enter the device name
that is registered on the FEN server. Make sure
that the device's FEN server information is entered
correctly. (System > IDIS Center Setup > Network
Setup > FEN) The device will not be detected if the
FEN server information is incorrect.

- Domain Name: If the device uses Domain Name
Service (DNS), enter the device's domain name
registered on the DNS server.

- Device Information File: Loads an .xml or .dat file
containing device connection information and
displays the corresponding devices on the list.
Select System > IDIS Center Setup > Save As File
> Device Information option and then select All
Devices or Device Group to save the current device
information of selected range and create a .dat file.
For more information about XML files, contact your
IDIS Center software retailer.

To select the devices to register, check on the box

next to the names of each device on the list. Click
Select All to select all the devices on the list at
once.
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Click Add Devices at the bottom of the Device Scan
window.

A user authentication window will appear.

- Name / Address / Device Type: Shows the name,

IP address and type of the selected device. If Sync
Device Names option was selected when setting
up the device, the device name displayed will be
automatically updated to the name entered in
device's settings.

- ID / Password: Enter the User ID and Password set

up on each device for remote access.

- Apply to All Devices: If multiple devices sharing

the same User ID and password are selected, you
can check this option to apply the same User ID
and password to all selected devices.

« If the selected device is a DVR, entering port
v numbers may be required depending on the
DVR's specification and version.
+ If the selected device is a 4-channel network
video server, all 4 cameras will be registered

automatically regardless of whether the
camera is enabled on the network video server.

Click Device Group on the Site panel and click <4 at
the bottom. Add Device Group window will appear.

CJ

- Name: Enter a name for the device group.
« Location: Select a location for the device group.

When you select a device from the device List on
the left, it will be added to the Selected Device List
on the right. Click OK to register the device group.



Make sure that the device has been added to the
device group correctly. Click Device Group on the
Site panel and click on » @ next to Device Group.
When you click on a registered device group, a list
of devices added the selected device group will be
displayed on the right. Check video analysis ( )
from the device group in the case of a device with a
video analysis device.

To modify a device group that has been registered,
select a device group and click [4 at the bottom
of the Site panel. A Modify Device Group window
will appear. You can modify the selected device
group from this window. For more details, refer to
Devices Management on page 24.
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Live Video Mode

In the Site List, make sure that the device has been
added to the device group.

In the panel tabs, click the Live tab. In the Site list,
select a site you wish to connect to. Then, drag &
drop the selected site on the Live screen using your
mouse. The live video of the selected site will be
displayed on the screen. For more information, refer
to the Live Video Mode on page 49.
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Recorded Video Playback
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In the Site List, make sure that the device has been
added to the device group.

In the panel tabs, click on the Play tab. In the Site
list, select a site you wish to connect to. Then, drag &
drop the selected site on the playback screen using
your mouse. The recorded video of the selected

site will be displayed on the screen. For more
information, refer to the Recorded Video Playback

on page 81.




System menu
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(2]
(6]
(3]
(4]
(5]
©® |Menu This is the menu bar. Refer to below for more details.
@O | sitelList Used to connect to a registered site using drag & drop.

(3) Live Event List

Shows instant events and callback events of registered devices. Click [l button
and then Emergency Event Panel will be displayed.

For more details, refer to Event Handling on page 99.

O |Live Popup List

Shows the list of current popup screens on IDIS Center. For more details on live
popups, refer to Live Popup on page 77.

6 Panel Toolbar /

Shows toolbar or timetable depending on the panel. For more details, refer to

Timetable Camera Control on page 61 or Recorded Video Playback on page 81.
Shows videos or list of the selected tab. For more details, refer to Panel on page
(6) Panel

20.
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Menu

System
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New Tab: Create a new panel. Up to each 6 and 4
panels can be created in total, including Live and
Playback panels. Up to 2 Map panels and 1 Report,
Operational Status, Device Status and Self-Diagnosis
panel can be created, respectively.

Remove: Removes selected device, camera or all
cameras from the Live screen or Playback screen.

Export, Print: Saves or prints the videos or list
displayed on the panel of the selected tab. (Some
panels are not supported.)

IDIS Center Setup: Changes basic settings.
Login/Logout: Logs in or out of the program.

Lock: Locks IDIS Center Program. Once the program is
locked, it will no longer be accessible and a password
entry field will appear. Enter password to unlock.

Exit: Exits or restarts the program.

View

Save to User Layout: Register the screen division and
device connection status of the selected Live or Plays
panel as a user layout.

Full Screen: Shows the selected Live or Plays panel in
full screen.

Full Screen + Toolbar: Shows the selected Live or Plays
panel with toolbar in full screen.

Reset Floating Tabs: Place all floating tabs on the
main tab.

Screen Format: Change screen layout.

Show Previous/Next Group: Switch to previous or
next camera group.

Show Format 1x1: Shows as a 1x1 format and turn it
off.

Select Previous/Next Pane: Select the previous or
next pane.

Screen Refresh: Refresh the video in the screen pane
in the Live or Plays tab.

Screen Magnifier: Magnifies the area near the mouse
cursor.

Pixel Counter: Shows the information of the pixel of
the selected area in Live or Plays.

Emergency Event Panel: Shows Emergency Event
Panel.

ANPR Event Panel: Shows a pop-up window of the
ANPR events panel.

Remote Site Panel: Shows or hides Site List from
floating panel or full screen. This function only
supports certain panels.



« Text-In Panel: Shows the text-in panel. It also displays
the text results on the panel.

Live

Set Hotspot: Set the selected camera screen as
hotspot screen.

Set Event Spot: Set the selected camera screen as
event spot screen.

Set Map Event Spot: Set the selected camera screen
as map event spot screen.

Set Browser: Sets the selected screen as the browser
screen.

Layout Sequence: Starts or ends a layout sequence.

Two-way Audio On/Off: Activates or deactivates
two-way audio (receiving and transmitting audio)
function.

MultiStream: Desired stream can be selected if
multi-stream mode is enabled for the live video of the
device.

PTZ Control: Controls PTZ for selected or all PTZ
camera devices.

Live Freeze: Freezes all screens of the selected live
tab.

Live Network Monitor: Shows bandwidth for each
device on a graph by time.

Recorder Storage Monitor: Provides storage device
information to the recorder added on the site.

Playback

Part 3 - Getting Started

- Play/Pause: Plays or pauses playing recorded video of
the selected device.

+ Play/Pause on Tab: Plays or pauses playing recorded
video of all devices displayed on the current screen.

+ Go to: Skips to the designated time.

+ Step Playback: Skips to previous or next video by
frame or time.

+ Export Video File: Saves video recording as a
proprietary viewer file(.exe) or an AVI file(.avi).

+ Thumbnail Search: Shows freeze-frame images of
videos recorded during events (Event and pre-event)
in the Play panel. For more details, refer to Recorded
Video Playback on page 81 and Thumbnail
Search on page 87

About

+ Privacy Policy: Choose whether to agree to the IDIS
Privacy Policy. Agreed devices can use FEN services.

- Keyboard Shortcuts: Displays a keyboard shortcut
description pop-up.

+ About: Shows software version and copyright
information.
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Site List

Shows a list of registered sites.

20

£, : Search registered sites. When a search query is
entered, matching results are shown as the query is
typed.

All Devices: Shows a list of registered devices. By
clicking a device on the list and dragging it to the
desired position on the screen, you can view live
video from the camera connected to the device or the
camera's video recordings.

This function is only supported for users in
Administrator group.

Device Group: Shows a list of registered device
groups. By clicking a device on the list and dragging

it to the desired position on the screen, you can view
live video from the camera connected to the device or
the camera's video recordings.

Layout: Shows a list of registered layouts. By clicking
a layout on the list and dragging it to the screen, you
can perform layout monitoring or playback.

Layout Sequence: Shows a list of registered layout
sequences. By clicking a layout sequence on the list
and dragging it to the screen, you can perform layout
sequence.

Camera Sequence: Shows a list of registered camera
sequences. By clicking a camera sequence on the list
and dragging it to a desired position on the screen,
you can perform camera sequence.

Map: Shows a list of registered maps. By clicking a
map on the list and dragging it to a desired position
on the screen, you can monitor videos on a map.

HDP: If a removable eSATA HDD or SD (SDHC)
memory card is connected to the IDIS Center system,
it shows the list of HDD or SD (SDHC) memory cards.
Connecting the removable HDD of a device to the IDIS
Center System requires a SATA «> USB 2.0 converter

or an IDE < USB 2.0 converter. Connecting an eSATA
HDD requires an eSATA cable, and connecting an SD
(SDHC) memory card requires an SD (SDHC) memory
card reader. For more information, contact your IDIS
Center software retailer. When you right-click on the
list, the storage information of the selected HDD or SD
(SDHC) memory card is displayed. Folder path, drive
type, device model, recording range, and capacity are
shown in the storage information.

Browser: Shows a list of registered browsers. Clicking
a browser on the list and dragging it to a desired
position on the screen launches the browser.

Panic: If there is a device that has created a panic
recording, it shows the list of corresponding devices.

Panel

Live: Shows live video.

Play: Used to play video recordings stored on the
device or panic recordings created by IDIS Center
program.

Map: Shows map.

VA Dashboard: Displays detected violations and
event occurrences from the VA device in a dashboard
format.

Report: Shows IDIS Center Program's log.

Health: Checks the status of devices registered in the
device group and shows the results.

Status: Shows the status of selected device in real-
time.

Self-Diagnosis: Shows and reports the status of a
recorder.

Browser: Allows the Internet browser function.



In the Panel tab, you can right-click to rename the tab.

Add or Delete Panels

To select a new tab click the System menu > New Tab .
To delete a panel, click 8 next to each tab.

Floating & Attaching Panels

You can make a panel tab float on top of other windows
by dragging the tab. You can click and drag the tab of the
floating panel to their original position to attach it back.
You can also use drag & drop to change the order of the
panel tabs.

« To maximize or restore panels, click on the
Maximize/Restore buttons at the upper left corner
of floating panels.
+ Right click on the screen of the floating panel and
select Remote Site Panel to show or hide Site list

in the floating panel. Not every panel supports this
function.

Part 3 - Getting Started
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Device

Configure the device-related settings.
Select System menu > IDIS Center Setup > Device.

aEN

| @

+ Always On Top: Keeps the Setup window always displayed in the foreground.
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Multiple Firmware
(1]
Upgrade

Upgrades the software of multiple devices at once.

Multiple Remote
(2]
Setup

Changes settings of multiple devices using settings file.

(3} Network Keyboard

Register, delete or modify network keyboards. Network keyboard can be used to
control IDIS Center program. For more details, refer to Control Using Network

Setup keyboards on page 121.
O | site Panel Shows a list of site groups supported by IDIS Center program.

® | siteList Panel

Shows the list of sites registered in each site group and related information. Click
on the » @ button next to the name of each device to view video inputs, alarm
input/output and audio input/output details supported by the device.

0O |search

Searches sites registered in each group. Select Device Group in Site panel and
enter the search query. When there is a match to the search query within the
selected group, matching results are shown as the query is typed.

© | Add, delete, modify

Adds, deletes, or modifies a site. Right click on Site and use the menu to delete
the site from the selected group or modify properties. If the selected site is a
device, you can connect to the device and change device settings or upgrade
device's software.

If a device is deleted from All Devices, then registered again, IDIS Center will consider it as a new device.

23
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Devices Management

Modify properties or delete a device from the list. You
can remotely change the device's settings or upgrade
the device's software.

24

Select Device Group on the Site panel. Then, click
Device on the Site List panel.

To bring up the Device menu, right-click on the
device or click on the [4 button at the bottom of
the Site List panel.

Edit Device: Modifies device's connection details.
Remote Setup Device: Changes device's settings
remotely.

Firmware Upgrade: Upgrades the device's
software remotely.

DirectNDC: You can use VNC (Virtual Network
Computing) to connect to the device.

VNC must be enabled on the device to establish
this connection. When registering a device

on IDIS Center program, the port number and

password for VNC remote connection must be

registered. This function may not be supported
depending on device's specifications and version.

» Clone Device: You can clone the registered device.
Device information is cloned identically when
cloning the device. You can change the device
information by selecting Edit Device from the
device menu of the cloned device. The device's
authentication procedure, which is entering the
user ID and password of the device, is not required
when changing the device information. A clone
icon( )isdisplayed at the device icon in the
device list to distinguish the cloned device.

- Update Device Information: Shows the newest
information of the selected device.

- Edit Identifier: Edits the identifier of the selected
device.

« Preview Video: Shows preview of video from the
device.

+ Delete Device: Deletes the device from IDIS Center
program.

Editing a Device: Information Tab

Click Edit Device on the device menu.
The device information can be modified.

+ Name: Renames the device. Names used by other
devices cannot be used.

The device is considered as not
registered.

Disable Device

Automatically updates device
name depending on the
device's settings.

Device Name
Sync




Automatically updates event
and device information
displayed on IDIS Center
program for all registered
devices. When multiple IDIS
Center systems attempt

to connect to the device
Device Real-Time | simultaneously, connection
Monitoring may fail depending on the
number of simultaneous users
supported by the device. If
this option is not selected,
event and device information
of the device currently being
monitored are updated
automatically.

Device Low The client operates according
Bandwidth to the low bandwidth
Communication | environment.

« Group: Shows the registered device group list.
« Device Type: Shows device type.

Editing a Device: Network Tab

Click Edit Device on the device menu.

The basic information for connecting to the device can
be modified. The device’s authentication procedure,
which is entering the user ID and password of the
device, is required.

Part 4 - Configuration

+ Address Type: Choose device's address type.

Auto Scan | The mDNS number can be entered
(LAN) when modifying device's address.

IP Address The I.P e?ddress .can be entered when
modifying device's address.

If the device uses FEN, a device name
registered on FEN server can be

FEN entered when modifying device's
address. The name entered must be
identical to the name set in device's
FEN settings.

If the device uses domain name
Domain service, a domain name registered
Name on DNS server can be entered when
modifying device's address.

- Address: The device's address can be modified
depending on the address type chosen above.

« Port: Port number can be modified. The port number
entered must be identical to the ports set for
Remote Access(Admin), Remote Watching(Watch),
Recording(Record) and Two-way Audio(Audio) on
the device.

- ID, Password, Connection Test: The device’s
authentication procedure is required to change the
information above. Enter the user ID and password
of the device and click the Connection Test button.
When the connection test succeeds, you can click the
OK button to apply the changes.

- Password Reissue: Reissue the remote device
password (Only for the products that support this
function).
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Editing a Device: Live Tab

You can set a live time limit.

- Live Time Limit: After accessing a live session on the
selected device, video and audio will no longer be
received after the set time has passed.

Editing a Device: DirectNDC Tab

You can register port number and password for VNC
(Virtual Network Computing) remote access.

+ Port, Password: Enter the port number and password
for VNC remote access.

« Scale to window size: Resizes the VNC viewer screen
to the window size.

+ Auto Reconnect: Automatically reconnects when

VNC remote access is lost.
26

- Enable Toolbar: Enables the toolbar of the VNC
viewer.

Editing a Device: Privacy Zone Tab

You can set up the privacy zone.

« Draw: Create a new privacy zone by drawing it with a
rectangle.

- Erase: Erase the existing privacy zone by drawing it
with a rectangle.

- Select Channel: Select the channel of the device for
which you set the privacy zone.

+ Stream: When setting a privacy zone, specify the
stream of the screen that is previewed.

Remote Setup Device

The device's settings can be changed remotely by
selecting Remote Setup Device in the device menu.
Certain settings items may not be supported by remote
setup. For more information on device setup, refer to the
device's operation manual. Settings of multiple devices
can be changed using settings file.

Click on the & (Multiple Remote Setup) button at
the top of the Site panel.



Click on the B button on the upper right corner
and select a setup file. A list of devices applicable to
the selected setup file will be displayed.

This feature may not be supported depending
v on the device model. Even if the setup file can be
applied to the registered device, Remote Setup

feature may not be supported. In such case, the
device is not displayed on the list.

Select a device and click on Apply button to change
the settings of the device.

Part 4 - Configuration

Firmware Upgrade

The software of multiple devices can be upgraded
remotely by selecting Firmware Upgrade in the device
menu.

Click on the (Multiple Firmware Upgrade) button
at the top of the Site panel.

Click on the E button on the upper right corner
and select an upgrade file. If the device is a PC-based
DVR, select PC-Based DVR and click .

A list of devices that can be upgraded using the
selected file will be displayed. Click Show All
Devices.

A list of all registered devices will be displayed.
Select a device and click on Upgrade button at the
bottom to upgrade the device.

Clone Device

The cloned device is listed in the left side. Select a
device group in the right side to add the cloned device
to the selected device group.
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Edit Device's I/0 Information

28

Select All Devices on the Site panel and click on the
arrow button » @ next to the device name on the
Site List panel.

Select an 1/0 device on the list of Video Input,
Alarm Input/Output and Audio Input/Output
supported by the device.

To bring up the Edit Device window, click on the [
button at the bottom of the Site List panel or right
click and select Edit Device.

« Device Name: Renames an I/O device.

« Associated Device: Select the camera channel to
display camera videos to the event spot screen
by connecting it to the I/O device. When Alarm
In, Detect Audio, or Detect Event are selected,
the video of the selected camera channel will be
displayed on the event spot screen.

+ Names used by other I/0 devices cannot be
\/ used. If the 1/0 device updates the name of the
connected device, the changes are updated

automatically.

+ Only supported if the I/O device is an Alarm In
or Audio Input device.

Devices Password Reissue

Reissue the remote device password. This function is
only for the products that support the device password
reissue function.

Device Password Initialization

When registering a device, the User Authentication
window pops up to ask whether to reset the
password in the case of the devices that need the
password initialization. For the device that needs
the password initialization, device registration is
enabled after the initialization. Click Yes to display
the password initilization window.
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Changing Device Password

Select Edit Device from the device menu, and click
Passsword Reissue on the Network tab.

Enter the information for the initialization and click
OK to reset the device password.

Select an authentication method and enter
the email address or phone number. Click
Authentication and enter the new password.

- New Password/Confirm Password: Enter the new
password.

+ Phone Number: Enter the phone number that
allows SMS for receiving the One Time Password
(OTP) when resetting the password.

- Email: Enter the email address for receiving the
One Time Password (OTP) when resetting the
password.
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Enter the information for the initialization and click
OK to reset the device password.

- New Password/Confirm Password: Enter the new
password.

Click the Connection Test button from Edit Device
to check the user authentication with the reissued
password.

Click OK when the connection test is complete.

Device Password Reissue

The password reissuance works only when the customer
service connection is available, since One Time Password
(OTP) is issued through the customer service. Ask your
dealer or retailer for more information.

If the user authentication fails (password error)
during the device registration, the window pops up
to check whether to reissue the password or not.



Click Request to reissue the password.

« ID: Enter the user ID that requests the password
reissuance.

- Authentication Method: Select an authentication
method between the email address/phone
number.

- Email Address/Phone Number: Enter the email
address or phone number that allows SMS for
receiving the One Time Password (OTP) when
resetting the password.

Part 4 - Configuration

Password Change Period
Expiration Notification

Users are notified of password renewals when their
password renewal cycle expires or is approaching in
the near future. Supported on devices that provide the
ability to periodically refresh passwords.

Change Password

Among the devices added to the site tree, when the
set password renewal cycle expires or the expiration
cycle arrives in the near future, a password renewal
notification window is displayed on the screen.

Click Change Now to appear the change password
window.

« User: Display the user ID of the device.
« Current Password: Enter the current password.

- New password, Confirm new password: Enter the
password to change. For Confirm new password,
enter the same characters as the New password.

. Site, Address: Display the name and the address
of the device.

Click ? button to see the password rules.
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Click OK to complete the password change, and if it
fails, a failure message is displayed.

Extend password change period

Among the devices added to the site tree, when the
set password renewal cycle expires or the expiration
cycle arrives in the near future, a password renewal
notification window is displayed on the screen.

Click Change Later to extend the password change
period, and if it fails, a failure message is displayed.
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Registers and manages users or user groups.
Click on System menu > IDIS Center Setup > User.

1l ]

|0

Group Panel

Shows a list of registered device user groups.

User List Panel

Shows the list of users registered in each user group and related information.

Search

Searches users registered in each group. Select a user group in Group Panel and
enter the search query.

| © 0o O

Add, delete, modify

Adds, deletes, or modifies user group or user.
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User Management

The authority for each function of IDIS Center can be set
differently by each user.

When you click on the + button at the bottom of
the User Group panel, an Add User Group window
will appear.

+ Information Tab: Enter a name for the user group.

 Device Access Authority Tab: Grant or restrict
access authority for each device.

« Authority Tab: Grant or restrict authority for each
function.

Click OK to add the user group.

Administrators group is authorized to use all
functions, and cannot be modified.
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When you click on the new user group and click the
<+ button at the bottom of the user group panel, an
Add User window will appear.

Disable: Check the box to disable the user.

Name: Enter a name for the user.

ID, Password, Confirm Password: Enter a unique
user ID and password for running IDIS Center
software.

Passwords can be set from 8 to 16 letters without
spaces.

No Password: Allows user to log in without a
password when logging on to IDIS Center .
Password Expiration Setup: Sets an expiration
date for the password. The user is notified upon
logging in if the password is expired.

User Specific Layout: Selects the user layout when
logging in to the IDIS Center.

Email: Enter an email address. The email address
must contain a "@".

Phone, Description: Enter a phone number and
description. Only digits and "-" can be entered in
the phone number field.



« User Specific Layout: Select a user layout for each
Live tab when operating IDIS Center.

Click OK.

.

By selecting a registered user group or user
and clicking the [4 button, you can modify
the information about the selected user group
or user.

« Show all registered users in the IDIS Center

system regardless of the user group if you
select All UserGroup.

«+ Select a registered user and drag & drop it in

the other user group to change the group.
Monitoring group is also changed when
changing the user group.

Part 4 - Configuration

OSD Watermark

Administrators of the Administrators group can set
the watermark to be displayed on the screen and set
whether to display the watermark for user groups.

When you click on the 22 button at the top of
the User Group panel, an OSD Watermark Setup
window will appear.

U

+ Use OSD Watermark: Select whether to display
the OSD watermark.

+ Apply to Administrator Group: Select whether to
display the OSD watermark of the user screen of
the Administrator Goup.

+ Mode: Text mode displays the text once at a
specified location on the screen. Text pattern
mode displays the text repeatedly. 35
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- Text: Specify the text to be displayed on the
screen. Use the text macro function via the button
on the right.

Allow or deny OSD watermark for the user group in
the Authority tab of the Edit User Group.

Panic Record

Allows user to manually start or stop a recording while
monitoring live videos.

Click on System menu > IDIS Center Setup > Panic
Record.
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Total Space: Shows the total space and available
space allocated for panic recordings.

Recorded Time: Shows the total duration of panic
recordings in the allocated storage space.

Overwrite: Shows whether Recycle is enabled or not.
Clear All Recorded Data: Deletes all panic recordings.

Reconstruct Abnormally Recorded Timetable: If

an error occurs while recording, the recorded data,
and therefore timetable information may become
out of sync and timetable in IDIS Center software

may display incorrect information. You can click
Reconstruct to restore the timetable information and
view the correct recorded data.

Overwrite recorded data when the disk is full :
When the allocated storage space becomes full,
the system overwrites existing data with new data,
starting with the oldest first.

Use Panic Recording: Enables Panic Recording.

Storage path: Set folder path of the storage space for
Panic Recordings.

Capacity: Allocates storage space for panic
recordings. From 4 GB to 64 GB can be selected.

A A live video must be displayed on the screen to create
a panic recording. If you switch to playback panel or

another panel in the middle of a panic recording, the
live video will no longer be displayed on the screen
and panic recording will stop automatically.



Panic Recording

On the Live screen, select a camera that shows the
video you wish to record.

Click @ (Panic Record) button in the control toolbar
on camera screen.

A Panic Record icon @ will be displayed on the
upper right corner of the camera's image and
recording will begin.

To stop recording, click @ (Panic Record) button
again.

Part 4 - Configuration

System

Configure the system language, automatic connection,
date, and time.

Click on System menu > IDIS Center Setup > System.

- Language: Select the language for IDIS Center.
Changed settings will take effect when the programis
restarted.

+ Reset Tab Name: This option is displayed when a
language different from the current language is
selected. When restarting the system after selecting
this option, every tab name is reset to the selected
language including the name entered by the user.

- Device Real-Time Monitoring: Select the range of
the Device Real-time Monitoring. This setting changes
the real-time monitoring status of the devices. If All
Devices Deactivated is selected, the Device Real-
Time Monitoring is removed from the Edit Device
window of each device.

- Disable display scaling on high DPI settings:
Uncheck to change the size of the client program
according to the DPI scale.

+ Use GDI DPI Scaling: Makes text more visible on high
DPI displays. This function is activated only when
the operating system supports Use GDI DPI Scaling
and "Disable display scaling on high DPI settings
function is disabled.

» Use hardware acceleration when available: Use
this function in an environment that meets certain
conditions.

+ Adjust windows visual effects: Choose whether to
change the window visual effects settings.
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Disable display power management at login:
Display power management option includes Turn off
the display and Put the computer to sleep.

Auto run IDIS Center at Windows startup: Runs IDIS
Center automatically at Windows start-up.

Pop up login notification: A message box will pop
up notifying login when logging into the IDIS Center
program.

Load user specific layout: Display the specific layout
which the user has set when restarting the program.

Startup Full Screen: Displays the full screen when the
program is restarted. You can click the Setup button
to select the panel displayed on each monitor.

CPU Usage Popup: Shows a warning if the IDIS
Center system's CPU usage exceeds a set value and
notifies the user.

Number of Processors to use: Set up the number
of processors to use during the IDIS Center program
running. It allows you to limit the CPU usage for the
IDIS Center program running.

Auto login at startup: Uses the previous login
information to login automatically upon IDIS Center
program startup. If Restore last Live sessions at
auto login option is enabled, previous Live session is
restored in the current Live panel.

Auto: Automatically logs out of IDIS Center program
or locks IDIS Center system if a mouse or keyboard
input is not detected for a set period of time while
logged in.

Date/Time: Displays current date and time.

Date Format, Time Format: Sets the format for
displaying date and time.

Start Week On: Sets the first day of the week.

Screen Format

Configure the camera screen and layout-related settings.

Click on System menu > IDIS Center Setup > Screen
Format.

General: Sets the position of side panel, position
of root map list in the panel, and position of text-in
panel.

Screen Format : Shows the basic layout of live screen,
playback screen and map screen. The screen layout
can be changed by clicking the Format Setup button.

Change the screen format based on the selected
camera: If enabled, the camera selected in the current
screen is positioned at the first camera screen when
the layout is changed.

Format expansion automatically: Layout expands
automatically depending on the number of devices to
connect to.

Use Full Screen Desktop Mode: When full screen

is activated, the full screen of the tab is additionally
displayed on the taskbar separately from the current
client S/W.



Screen Display

Sets OSD(On Screen Display) display method on the
camera screen and enables / disables OSD.

Click on System menu > IDIS Center Setup > Display
0OsD.

- Opacity: Adjusts the opacity of OSD using a slider.

- Selected Pane No Border: Hides the border of the
selected pane.
+ Selected Pane Title Bar Only: Displays the title bar of
the selected pane.
« Live, Playback: Configures OSD information
displayed on the screen.
- CameraTitle: Displays the camera name set in IDIS
Center program.
- Title bar: Separates the title display area at the top
of the camera screen.

- Recorded Title: Displays the name of the camera
configured during video recording.

Part 4 - Configuration

- Status Icon: Displays status OSD.

@ Panic Record in progress
@ PTZ

w Camera Sequence

& Zoom In

Device record in progress

8 Talk

) Listen

- PTZ: Adjusts pan & tilt control buttons on the
screen when controlling a PTZ.

- Date, Time: Displays current date and time of IDIS
Center system.

- Event Alert, Event Alert Dwell Time Turns the title
bar of a camera to red when an event occurs on
the device. The event warning is displayed for the
duration set for event warnings and disappears. If
Manual Off is selected, event warning disappears
when the user selects the camera screen.

- Motion Block: If a motion detection event occurs
on a device, the part of the screen where motion is
detected is displayed as a red block. Only supports
network video servers.

- ePTZ: Displays the guide GUI (Graphic User
Interface) when you control PTZ in the fisheye
camera.

- Site Name: Displays the name of the device.
Displays only if camera name and device name are
different.

- Text-In, Text-In Dwell Time: If a text-in event
occurs on a device, text-in information is displayed
on the screen. Only supports 1x1 layout. The Text-In
information will be removed after the Text-In Dwell
Time from the time an event occurred.

- Message: Displays message on the screen. For
more information on screen messages, refer to the
Network section on page Network on page 44

Position: Used to adjust the OSD's position, text size,
and margin.

Text-In: Used to change the color and size of the
text-in.
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- Control ToolBar: Adjusts the opacity of control - Use Main Hover ToolBar: Sets whether the hover
toolbar on camera screen using the Opacity slider. toolbar is displayed in the camera pane. When

functions are executed via the context menu, the

hover toolbar is displayed regardless of this setting.

- Popup on the Hover Zone: Toggles on/off the
toolbar by a mouse cursor position in the hover
zone.

OSD on each camera screen in Live screen

Event Alert

- Camera Title: Indicates the camera's title.

« & /8 (Listen or talk): Indicates that IDIS Center
program is receiving audio from the device or sending
audio to the device.

« [® (PT2): Indicates that PTZ can be controlled.

. (Camera Sequence): Indicates that camera
sequence is in progress.

« @ (Panic Record): Indicates that panic record is in
progress by IDIS Center system.

. (Device Record): Indicates that device record is in
Motion Block progress by IDIS Center system.

« (® (Zoom): Indicates that the video is zoomed in.

- &3 (Freeze-frame): Indicates that freeze-frame
function is used on the live video when connecting
to INK.

. #3 (Color Control) : Indicates that color control is in
use.

- ] (Image Effect): Indicates that image effect is in use.

- Date, Time: Displays current date and time of IDIS
Center system.

- Event Alert: Indicates that an event has been
detected.

Control ToolBar

+ Motion Block: A block is displayed over the area of
40



video in which motion event was detected.

Only supports network video servers.

Screen Menu

Add or remove the context menu items on the live tab.

Click on System menu > IDIS Center Setup > Screen
Menu.

+ Remove disabled menu items: Removes the
disabled menu items from the context menu.

Video Enhancement

Configure the video-related settings.

Click on System menu > IDIS Center Setup > Video
Enhancement.

Part 4 - Configuration

Aspect Ratio: Sets the aspect ratio of video output.

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.

- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.

- Fit to Screen(Smart): Resizes video according to
the extra spaces, to the Fit to Screen or Actual
Size.

- Fit to Screen(Aspect ratio): Resizes video to
camera screen while maintaining original aspect
ratio.

Left and right part of the video may be cropped

. depending on size of camera screen. When using
Zoom, Hotspot, Event Spot, Show Motion Block
features, Original Ratio is applied instead of camera
screen aspect ratios.

- Actual size (1x): Displays the video in actual size.

Drawing Mode: Choose the drawing mode for video
display on the screen. The overall color and display
performance may vary depending on drawing mode
settings.

Maximum Frame Size: Select the maximum frame
size to display on screen.

Frame Skipping: Select the frame skipping to
enhance video performance if the video exceeds the
decoding specification.

- Level 1-Based on system specifications: Apply
frame skipping in decoder configurations that
exceed video decoding specifications.

- Level 2 - Include when the pane size is smaller
than the video resolution: Apply frame skipping
if the size of the target camera pane is smaller than
the size specified by the original video resolution.

- Level 3 - Turn off loop filter: Applies codec's loop
filter off when skipping frames. 41
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Low Latency Mode: Minimizes frames to be decoded
in parallel to reduce DPB (Decoded Picture Buffer).

Deinterlacing: If the video is encoded in interlaced
mode, this option removes horizontal stripes or noise
that may occur during movement to improve video
output quality. Select the desired de-interlacing filter.

This feature requires high specification as it reduces
buffering, parallel processing and post processing.

Important Video Performance: Puts speed over
quality of video output when displaying videos on the
screen.

Anti-Aliasing: Removes stair step (blocks) artifacts that
are caused when zooming a video to improve overall
quality of video output.

High-Quality Downscaling/Upscaling: Maintains the
quality of video output when downscaling/upscaling
the video.

Trim The Black(noise) Edges: Removes black borders
(noise) around videos.

Monitor Vertical Sync: Improves tearing artifacts
caused when the monitor's refresh rate is low.

Dynamic MultiStream Control: IDIS Center can be set
to use different streams depending on layout. If Auto
is chosen, IDIS Center will automatically set the most
appropriate stream for the layout.

Interactive Bandwidth Control: Changes resolution
and frame rate of the device depending on layout to
control network bandwidth. It allows more efficient
use of network bandwidth and prevents performance
drops in IDIS Center System caused by network
overloads.

Only supports 1x1 layout. CPU usage may increase if
this option is enabled.

Only supports devices that use more than one
stream.

- 1x1 layout: Maximum resolution and transfer speed
supported by the device.

- Multiple layout: Resolution and frame rate lowered
to an appropriate level for each layout

.

« This function only applies to Live videos.

This function must be supported by the device to
operate properly.

+ Use H/W Acceleration - iGPU: Enables hardware
acceleration for high-quality video processing. This
option is only available if the user's PC supports
hardware acceleration.

+ Use GPU Decoding - DXVA2: Enables GPU decoding
in the IDIS Center program. It may enhace processing
of HD (High-Definition) video. This option is available
only when GPU decoding is enabled in your PC.



Video Analysis

Configure video analysis-related settings.

Click on System menu > IDIS Center Setup > Video
Analysis.

Object Detection

Undefined

Highight :

«+ Color Settings: Set the color of the image analysis
result overlaid on the image by object type.

- Display Object Type: Displays the object type in the
image analysis result.

- Display Accuracy: Displays the accuracy of the video
analysis results.

- Display Colors: Displays the colors of the video
analysis results.

Part 4 - Configuration

Report

Configure log output-related settings.
Click on System menu > IDIS Center Setup > Report.

Number of results displayed on the list: Set the
number of logs to be displayed per page.

For Device Log, default is 100 regardless of above
settings.

Update Interval: Configure the update interval of
status displayed in the operational status panel. Select
Not Use to disable the Health status panel.

Connection Retry Count: Set up the maximum
number of connection retries.

Status Request Timeout: Set up the maximum waiting
time for device status request.

Save problem status as: Save the log of the selected
problem items as PDF or CSV according to the update
interval. Set up the storage folder with a title and
password (PDF only).

Popup problem status notification: Display a popup
notification when a problem occurs from the selected
problem items according to the update interval. The
popup notification displays issue related information,
and click Self-Diagnosis to start the self-diagnosis.

Popup Timeout: Set the time for automatic closing of
the problem status popup window. Select Infinite for a
user to manually close the popup.
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Instant Event

Configure Live event-related settings.

Click on System menu > IDIS Center Setup > Instant
Event.

« Use Event Panel: Displays the Instant Event List panel.
Unchecking the box hides the panel.

- Time Range: Sets the duration in which each event is
displayed in the Instant Event list.

- If the event list is less than 100, event notification
\/ does not disappear from the live event list even if
the duration passes.

+ Column: Selects the information to be displayed on
the live event list.

. Callback Port: Set the port number for receiving
callback messages from the device. Port number must
be identical to the port number set on the device for
remote callbacks.

« Live Text-In Time Range: Set the duration in which

text-in data is displayed when text-in event is detected.

Text-in data can be checked in the text-in viewer
window during the set duration after text-in event has
occurred. For more details, refer to Text-ln Viewer on
page 73.

+ Treat <Device Disconnection> Event as Emergency
Event: When a device is disconnected, the

disconnection event is treated as an emergency event.
- Event Sound: Enable audio notification when an event

occurs. Select the desired event, and click I to set
the audio file (.wav) to be played. You can preview the
selected audio file by clicking I3.

a4

- Auto disable when Two-way Audio is on.: Set up to
automatically turn off the event sound when using
the two-way audio.

- Event Spot: Shows the camera video in which an event

occurred on the event spot screen.

- Event monitoring dwell: Set the duration in which
video is displayed on the event spot screen.

- Minimum monitoring dwell: Set the watch
duration of current event when another event is
detected while current event is being displayed. The
camera video of the latter event is displayed after
the set duration has passed.

 Intercom: When the intercom call is received, when an

event is detected, a pop-up screen appears.

- Not Use: Do not specify the setting when a call
request is received.

- Notification: Display the intercom notification
popup.
- Intercom Popup: Display the intercom popup.

Network

Configure network-related settings.
Click on System menu > IDIS Center Setup > Network.

- Buffering for HD Live: When monitoring a HD

video, short term#teng-term buffering can be used to
smoothen video playback. Buffering may be delayed
or live video may be delayed depending on network
conditions.



Live image no frames detect interval: Set the interval
for transmission of video frames. If a video frame is not
transmitted to IDIS Center system for the set duration,
a message is displayed on the corresponding camera
screen.

Disconnection Message: The on-screen messages
for indicating lost connection to the device or camera
status can be changed. Click Setup..., then check the
boxes next to each message and change the message.

FEN: If there is a device that uses FEN, enter the device
name that is registered on the FEN server. If the device
name entered is incorrect, system will not be able to
register and connect to a device that uses FEN. The
client NAT type is displayed.

Use FEN: Check Use FEN to use FEN.

RTP Incoming Port Range: Set the inbound RTP
port range if a device that transmits video using RTP
protocol is registered.

If network firewall or local area network only allows
A certain UDP/RTP ports, the RTP port range must be
set to those ports allowed. Make sure that the port
numbers do not overlap with general streaming
programs. Overlapping port numbers may result in
failure to monitor videos.

Don't display broken frames: When using RTP
protocol, frames may be corrupted or lost depending
on network conditions. In such case, this option allows
user to choose whether to display corrupted frames on
Live or Playback panels.

Buffering Frame Count: Set the number of buffered
frames to be used in RTP protocol. Higher number will
result in smoother video playback, but also causes a
delay in the video.

Use Network Keyboard: IDIS Center program can be
controlled using network keyboards. Set the port to
be used by IDIS Center program. Enabling Use large
mouse cursor increases the size of the mouse cursor.
Enabling Use the arrow buttons to select a pane
selects a pane with the arrow buttons of keyboard. Use
Enabling MFZ camera control controls MFZ cameras
using the network keyboard.
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Playback

Configure playback settings.
Click on System menu > IDIS Center Setup > Playback.

Session Timeout: Set a session timeout in Play/
Instasnt Play. The session will be disconnected after the
set time.

Event Time Shift: Set up to search the frame before
the specific time based on the event-related frame
time.

Dual-Stream Playback Priority: Set up to select the
default stream for the dual-stream playback. Playback
is performed from the 2x2 layout for Dynamic Control,
from layouts under 2x2 for Main Stream Priority, and
from the other layouts for Sub Stream Priority.

Prefer Responsiveness When Searching Time
Overlap: When searching for a section in which many
segments exist, the search is performed by limiting the
number of the latest segment.

Playback without Time Overlap: Displays without
segmentation on the time table when a time overlap
occurs. Sections with time overlap use the recording
data of the latest segment.

Use All Key Frames For Fast Playback: When playing
back recorded video at high speed, all keyframes are
played.

Prefer Responsiveness to Time-Precision: Displays
the closest time frame possible while reducing the loss
of responsiveness, preferred than time-precision, when
performing the GoTo function on a Long-GOP image.

Key-Frame mode forced on Long-GOP backward
playback: Set up to play the key-frame only on Long-
GOP backward playback.

Timetable: Specify the color to be displayed in the
timetable for each recording format.
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Site

Configure site settings.
Click on System menu > IDIS Center Setup > Site.

- Expand All Devices Item: All device items in the site
tree are expanded upon login.

- Expand Device Groups: Displays the devices in the
device group of the Site list when monitoring video or
playing recorded video.

« Show Disabled Devices: Displays or hides the
disabled devices in the Site list.

» Show Device Real-Time Monitoring: Set up the way
of displaying device real-time monitoring (Not use,
icon ,greenoverlay )on thesite tree.

- Item: Displays or hides the list of input/output
devices supported by the device in the Site list when
monitoring video or playing recorded video.

46

Map

Configure map-related settings.
Click on System menu > IDIS Center Setup > Map.

+ Use Live Popup Panel: Displays the Live Popup List
panel. Unchecking the box hides the panel.

Use Event Sound Multiple Play: Simultaneously plays
each camera's sound file when events occur at multiple
camera sites at the same time. Uncheck the box to play
the first event's sound file.

Activate Auto Focusing: Zooms in on the zone where
the device is located on the map when a designated
event occurs.

- Focusing Event: Designate an event to auto-focus
on.

- Focusing Duration: Set the duration of auto-focus.

- Focus Minimum Dwell: Set the minimum auto-
focus duration for the first event when consecutive
events are detected on different devices. The auto-
focus will switch to latter event after the set duration
has passed.

Zoom Finder: Shows or hides PIP screen. The square
of PIP screen displays the zoomed area. If Auto is
selected, PIP screen is only displayed when canvas is
zoomed in.

Map Event Spot: Shows the camera video in which an
event occurred on the map event spot screen.

- Event monitoring dwell: Set the duration in which
video is displayed on the map event spot screen.

- Minimum monitoring dwell: Set the watch
duration of current event when another event is
detected while current event is being displayed. The
camera video of the latter event is displayed after
the set duration has passed.



- Instant viewer: Set the duration of instant viewer.

- Instant viewer is displayed when the camera is
clicked on the map.

Browser

Browser Start Page: Specify the browser's start page.

Fit to Pane: Adjusts the web page to fit the size of the
browser screen.

Enable Popup: Allows popup pages.

Popup All New Window: Displays the web page's
popup screens as separate screens.

Part 4 - Configuration

Action

Configure action-related settings.
Click on System menu > IDIS Center Setup > Action.

+ General: Set the general action on the live popup.

- Use Ctrl+Popup Pane Drag: Press Ctrl button and
drag the live popup to a pane on the Live tab to
display the image on the pane.

- Use Multiple Two-way Audio: Speaking and
listening functions only work for a single camera
when it is unchecked.

- Use Listen when changing to screen Format 1x1:
The listening is worked when changing to 1x1 screen
format. (Enable Multi-Way Audio function cannot be
used simultaneously with this.)

- Turn off two-way audio when pane is deselected:
When selecting a different pane while two-way
audio is active in the selected camera pane, the
two-way audio function in the previous pane will be
disabled.

- Enable PTZ Automatically: Set PTZ control function
automatically.

Live Popup: Double-click on the pane to practice the

following fuctions.

- Maximize or Restore

- 1x1Pane on Live Screen

- Maximize on Application Monitor

Instant Viewer: Double-click on the predefined

button, between the middle or the right button, of the
mouse to perform the following functions.

- 1x1 Pane on Live Screen
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Turn (e)PTZ Functions On: Set PTZ control function
on default.

Disable Time Out: Disables the popup dwell time
out after Action.

Fisheye: Set up the default Action when accessing a

fisheye camera.

Startup Preset: Set up the preset name to be used
when accessing a fisheye camera. If each camera's
format is saved under the same preset name, it is
easier to change the format.

Default View Mode: Set the default view mode.
Image Ratio: Set the image ratio.

ePTZ Frame Rate: Set the ePTZ frame rate. High
(Over average of 60 Fps), Normal (Over average of 30
Fps), Low (Average of 15 Fps), Very Low (Average of 5
Fps) - a PC with a low specification is appropriate.

Auto Pan Frame Rate: Set the auto pan frame

rate. High (Over average of 60 Fps), Normal (Over
average of 30 Fps), Low (Average of 15 Fps), Very Low
(Average of 5 Fps) - a PC with a low specification is
appropriate.

Use ePTZ: Uses ePTZ when accessing a fisheye
camera.

Save

Configure still image saving-related settings.
Click on System menu > IDIS Center Setup > Save.

- Still Image: Set still image related options.

- Folder: Select a folder to save the still image.

- Filename: Set a name of the folder for saving the
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stillimage. Supported extensions include JPG, WebP,
PNG, TIF, BMP and PDF.

Include Image Information: Include image
information in the saved still image file.

Clip-Copy: Set video related options.

Include Digital Signed Player: Select to save the
recorded image including the digital signed player.
This option is activated when saving the video.

Use Default File Path: A video is automatically
saved in the pre-set default file path with the default
filename.

Folder: Set the default folder to use when saving a
video.

Filename: Set the default filename to use when
saving a video.

Prompt for Case Number when saving: Displays
the Case Number input window when saving a
video, and the entered Case Number is filled in the
$(CaseNumber).

Create new folder using Case Number: Displays
the Case Number input window when saving a
video, and a folder of the entered Case Number is
created in the default file path. The video is saved in
the created folder.

Backup/Restore

IDIS Center program's settings can be saved as "iexp" file
or saved settings can be imported and applied to current
IDIS Center program.
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Live Video Mode

Live videos of registered sites can be monitored. IDIS
Center program receives videos according to the
device's settings and displays live videos. Up to 4 Live
panels are supported for monitoring live videos. If Live
tab doesn't exist in the panel tabs, you can add it by
clicking New tab > Live in System menu.

In the panel tabs, click the Live tab.

In the Site list, select a site you wish to connect
to. Then, drag & drop the selected site on the live
screen using your mouse.

The live video of the selected site will be displayed
on the screen.

+ You can select and move a cameratoa
\/ desired position on the Live screen without
disconnecting by selecting the camera being

monitored and moving it using drag & drop
with your mouse.

+ Monitoring or playing 2 or more camera videos
on a PC with a low specification may cause the
performance of IDIS Center system to drop.
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Panel Toolbar

The Live panel can be controlled by using the panel toolbar at the bottom.

Ll
o

| L) OO 00
9006 000000 © O

2]

© | savetoUser Layout Saves current screen layout and device connection status as a user layout.

® | screen Format Change layout. Various layouts can be selected by clicking 4 button. You can
switch to previous or next camera group by clicking <7 or .

(3) Hotspot Sets the selected screen as hotspot screen.

O | Event Spot Sets the selected screen as event spot screen.

©® | Map Event Spot Sets the selected screen as map event spot screen.

(6] Layout Sequence Starts or stops layout sequence.
+ Remote Site Panel: Shows or hides a site list in the floating panel or full screen.

© | Additional Menu Not every panel supports this function.
» Text-In Panel: Shows the Text-In panel.
- Save Still Image: Saves the current frame of the video on the screen as an

image file in actual size.

(6] Export Image - Export Image File, Print Image: Save or print current image on the screen.

- Export Panorama Screen: Save the image currently shown on the screen and
the floating panels.

© | Audio Broadcast Broadcasts audio to all devices in the current Live tab.

@ | NVRTwo-Way Audio Receives audio from the NVR device or sends audio to the NVR device.

@ | Panic Recording Starts panic recording of videos from all devices in the current Live tab.
Shows the Text-In panel. The Text-In panel shows the text-in data of the devices
currently connected to the IDIS Center. If a camera is associated with the text-in
device and the video of the associated camera is displayed on the current Live

@ | Text-In Panel screen, the text-in data is displayed on the video on the camera screen, too. You
can change the length of time that the text-in data is displayed by using the Live
Text-In Time Range setting. For more details about the Live Text-In Time Range
setting, refer to Instant Event on page 44.

® | Browser Sets the selected screen as the browser screen.

50



Part 5 - Operation

Set Hotspot Set Map Event Spot

Map Event Spot is a camera screen designated to
emphasize the videos in which events occur on a map
while monitoring a video. A map event spot screen is
marked by gray border.

Hotspot is a camera screen designated by the user to be
emphasized while monitoring a video. A hotspot screen
is marked by red border.

Select a camera screen to set as hotspot screen from
the screens currently being monitored. Select a camera screen to set as map event spot

screen from the screens currently being monitored.

Click [E] at the bottom of the Live panel. Program
will be connected to the selected camera screen and
previous connection will be terminated. A hotspot
screen is marked by red border.

Click JE] at the bottom of the Live panel. Program
will be connected to the selected camera screen
and previous connection will be terminated. A map
event spot screen is marked by gray border.

When a camera is selected on the screen, the
selected camera will be displayed in the hotspot
screen and the selected camera can be controlled.

When an event occurs on the screen, the camera in
which the event occurred will be displayed in the
map event spot screen.

Set Event Spot
Browser Screen Settings

Event Spot is a camera screen designated to emphasize
the videos in which events occur while monitoring a

video. An event spot screen is marked by blue border. Select a camera screen to set as browser screen from

Select a camera screen to set as event spot screen
from the screens currently being monitored.

Click [E] at the bottom of the Live panel. Program
will be connected to the selected camera screen and
previous connection will be terminated. An event
spot screen is marked by blue border.

When an event occurs on the screen, the camera in
which the event occurred will be displayed in the
event spot screen.

the screens currently being monitored.

Click |E] at the bottom of the Live panel. Program
will be connected to the selected camera screen and
previous connection will be terminated.

Web browser page appears on the browser screen.

+ = (Menu): Displays the browser menu.

4= % (Previous page, Next page): Navigate to the
previous/next page.

[ M (URL entry): Used to enter a URL (Uniform
Resource Locator) address. Click ' on the right
after entering an address to load the URL.

(¥ % (Refresh/Stop): Refreshes/stops the web
page.

[ (Fit to Pane): Adjusts the web page to fit the size
of the browser screen.

Enable Popup: Allows popup pages.
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- Popup All New Window: Displays the web page's
popup screens as separate screens.
- Print: Prints current web page.

- Remove: Releases the setting of as browser screen.

Screen Format

Screen Format in the IDIS Center program indicates
\/ the divided image pane arrangement on the live or
play panel. Select from screen formats on the panel

toolbar or click the g (Screen Format) button to select
from additional screen formats and apply to the panel.

Screen Format includes default Normal Format, Wide
Format and customized User Screen Format. Clicking
the left mouse button on the screen format applies
the selected format to the panel, and clicking the right
mouse button selects the chosen screen format.
Hovering the mouse over a screen format item displays
a tooltip with screen format information. User Screen
Format items are arranged in alphabetical order and in
order of number of panels.

. (Add): Adds a user screen format.
. (Modify): Edits user screen format information.

. (Delete): Switches to user screen format delete
mode. Click on a User Screen Format item to remove
the item.
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User Screen Format Add/Modify

Clickthe (Add)or (Modify) buttons of User

Screen Format to add a new format or edit the format
information. Select a format item using the right mouse
button or arrow keys to activate the  (Modify) button.

- Name: Enter a name for user screen format.

+ Sharing: Select user range for the chosen screen
format.
- Public: Displayed to all users.
- Group: Displayed to the users in the owner group.
- Private: Displayed to the owner only.

« Column, Row: Indicates the number of column and
rows of the screen format.

- Ratio: Displays the horizontal, vertical ratio of the
panel. Selecting Auto uses the ratio of the monitor
displaying the Client. Selecting Default indicates
the panel ratio configured before the screen format
modification.

- [ (Merge): Merges the selected panes into a single
pane.

- [ (Unmerge): Splits the selected pane into panels in
default size.

« Clicking the middle mouse button on the panel
v merges, and clicking the right mouse button
unmerges the pane.

« Up to 64 panes are available on the panel in
maximum.



Layout Monitoring

Videos from multiple cameras can be monitored using
a predefined layout. A layout must be registered to use
layout monitoring.

In the Layout list, select a layout you wish to to
use. Then, drag & drop the selected layout on
the live screen using your mouse, or double-click
on the Layout Device to display on the selected
monitoring tab.

The camera videos added the layout will be
displayed according to the predefined layout.

<& =

Part 5 - Operation

Registering an User Layout

Saves current screen layout and device connection
status as a user layout. Click the  (Save to User Layout)
button on the panel toolbar of the Wall Control tab to
create user layout information.

« Name: Enter a name for user screen format.

- Sharing: Select user range for the chosen screen
format.

- Public: Displayed to all users.
- Group: Displayed to the users in the owner group.
- Private: Displayed to the owner only.

+ Group: Select the layout group containing the user
layout.

- Description: Enter the description for the user layout.
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Registering a Layout Group

Select Settings in System menu and select the
Device menu.

On the Site panel, click on Layout, then click on the
<+ button at the bottom of the Site panel on the
left. An Add Layout Group window will appear on
the screen.

- Name: Enter a name for the layout group.
- Description: Enter the description for the layout
group.
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Registering a layout

Select Settings in System menu and select the
Device menu.

On the Site panel, click on Layout, then click on the
+ button at the bottom of the Sites List panel on
the right. An Add Layout window will appear on the
screen.



Name: Enter a name for the layout.

Sharing: Specify the users who can see the layout
being registered. The admin user can see all
layouts.

- Public: Shows the layout to all users.

- Group: Shows the layout to a specific group of
users. You can select the group from the Owner
list.

- Private: Shows the layout to the individual users
selected from the Owner list.

Owner: Allows you to show a different layout to
different users.

Site: Shows the registered devices, cameras,
camera sequences and map list. A registered
device or camera sequence can be searched by
entering a query in O, field.

Screen Format: Select the layout. In Site list, select
the device, camera, or camera sequence you wish
to allocate and drag & drop them to the desired
position in the layout screen using your mouse.
(Delete) : By selecting a specific screen in the
layout and pressing the delete button, you can
delete the camera allocated to the selected screen
from the layout.

EH (Hotspot) : By selecting a specific screen in the
layout and pressing the hotspot button, you can
set the selected screen as a hotspot.

EH (Event Spot) : By selecting a specific screen in
the layout and pressing the event spot button, you
can set the selected screen as an event spot.

(Map Event Spot) : By selecting a specific screen
in the layout and pressing the map event spot
button, you can set the selected screen as a map
event spot screen.

(Camera Sequence): By selecting a specific
screen in the layout and pressing the camera
sequence button, you can create a new camera
sequence. The new camera sequence is allocated
to the selected screen.

Click OK to finish adding a layout.

Part 5 - Operation
Layout Sequence

Videos from multiple cameras can be monitored
sequentially using two or more predefined layouts.
A layout sequence must be registered to use layout
sequence function.

In the layout sequence list, select a layout sequence
you wish to to use. Then, drag & drop the selected
layout sequence on the live screen using your
mouse. The camera videos added to the layout
sequence will be displayed sequentially in each
layout.
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Example of layout sequence

You can stop or resume a layout sequence by

clicking f@ in the toolbar at the bottom of the panel.

Registering layout sequence
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Select Settings in System menu and select the
Device menu.

On the Site panel, click on Layout Sequence, then
click on the 4 button at the bottom of the Site
List panel on the right. An Add Layout Sequence
window will appear on the screen.



If a layout for sequential monitoring is not
registered, click Add Layout.

C_J

Click Add Layout and register layouts for sequential
monitoring. Two or more layouts must be registered
to use layout sequence.

Part 5 - Operation

Name: Enter a name for the layout sequence.
Sharing: Specify the users who can see the layout
sequence being registered. The admin user can
see all layout sequences.

- Public: Shows the layout sequence to all users.

- Group: Shows the layout sequence to a specific
group of users. You can select the group from
the Owner list.

- Private: Shows the layout sequence to the
individual users selected from the Owner list.

Owner: Allows you to show a different layout
sequence to different users.

Layout List: Shows a list of registered layouts.
Registered layouts can be searched by typing
search query in the £, field.

Selected Layout Sequence List: Shows a list of
layouts registered for layout sequence.
Duration (sec): Shows the display duration for
each layout. Double clicking the number will allow
you to change the duration time for this specific
layout. The set duration can be applied to all
layouts by clicking Apply all.

Select a layout from the Layout List and click
to add the selected layout to Selected Layout
Sequence List.

Click OK to finish adding a layout sequence.
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Camera Sequence Example of camera sequence
CAM CAM
Videos from multiple cameras can be monitored 1 5

sequentially on the same camera screen. A camera

sequence must be registered to use camera sequence
function.

In the camera sequence list, select a camera
sequence you wish to use. Then, drag & drop the
selected camera sequence on the live screen using
your mouse. The video from cameras added to the

camera sequence will be displayed on the screen CAM
sequentially. 1

Camera 1 Camera 5

CAM
5

EHgER

:
|||

You can stop or resume a camera sequence by
clicking g in the control toolbar at the bottom of
the camera screen.
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Registering a camera sequence

Select Settings in System menu and select the
Device menu.

On the Site panel, click on Camera Sequence, then
click on the 4 button at the bottom of the Sites
List panel on the right. An Add Camera Sequence
window will appear on the screen.

« Name: Enter a name for the camera sequence.
+ Sharing: Specify the users who can see the camera
sequence being registered. The admin user can

:] see all camera sequences.

- Public: Shows the camera sequence to all users.

- Group: Shows the camera sequence to a specific
group of users. You can select the group from
the Owner list.

- Private: Shows the camera sequence to the
individual users selected from the Owner list.

« Owner: Allows you to show a different camera
sequence to different users.

- Device list: Shows a list of registered devices.
Registered devices can be searched by typing
search query in the £, field.

« Selected Camera Sequence List: Shows a list of

C] camera registered for camera sequence.

- Duration (sec): Shows the duration in which video
from each camera is displayed on the screen.
Double clicking the number will allow you to
change the duration time for this specific camera.
The set duration can be applied to all cameras by
clicking Apply all.

Select a camera from the device list and click B to add
the selected camera to Selected Camera Sequence
List.

Click OK to finish adding a camera sequence.
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Map Monitoring

The camera videos of registered devices, events, and
status of connection I/0 devices can be monitored on a
map.

For more details on map registration, refer to Map.
Editor on page 115.

« A map must be regmaistered to use map
\/ monitoring.

« Map monitoring supports up to 4 Live panels and
Map panels.

« IfaLive tab or Map tab doesn't exist in the panel
tabs, you can add them by selecting New Tab in the
System menu and clicking Live or Map.

Place the mouse cursor over the I/0 device on the map
to view the event detection and status of the I/0 device.
If an event has been detected on the I/0 device or if the
device is not operating properly, it will be indicated by

. . the following icons.
In the Map list, select a map you wish to to use.

Then, drag & drop the selected layout on the live
: %) Disconnected & Not configured
screen using your mouse.
Abnormal
(1] . & Motion detected
operations
@ | Videoblind & | Video loss
|:D ) Video-analyti
I~ Museum search X aeo .ana yHe
detection
& Trip zone I | Tampering
» Alarm-in o Alarm-out
The selected map will be displayed on the screen. * Upto4icons may be displayed at once.
- Certain event icons may not be supported
+ You can select and move amap to a depending on device's specifications and version.
desired position on the Live screen without

» Event Detection icons will be displayed depending
on the event detection settings of the device in
which I/0 device is connected to.

disconnecting by selecting the map being
monitored and moving it using drag & drop

with your mouse. L X X
- Abnormal Operation icons will be displayed

depending on the system check settings of the
device in which I/0 device is connected to.

+ Select 1/0 Device from the map and drag &
drop the subject device to the Live screen,
Play panel or Device Status Panel to view live
or recorded videos from the subject device, or
monitor the device's status.

- If a status color was set when registering the
map, events and statuses will be displayed by the
corresponding colors.

- When two or more events or status changes occur
simultaneously, the colors that correspond to each
event or status will be displayed one after the other.
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Path sequence

When using Map monitoring, videos from multiple
cameras registered to the map can be monitored
sequentially on the same camera screen. A sequence
route must be registered to use route sequence. For
more information, refer to the Path Sequence on page

118.

On the map, select a sequence route you wish to to
use. Then, drag & drop the selected sequence route
on the live screen using your mouse.

Videos from cameras in the route sequence will
be displayed sequentially on the screen for the set
duration.

Part 5 - Operation

Camera Control

Controls the camera using the control toolbar and
screen menus.

Control toolbar

Select a camera screen and place the cursor over the
camera screen to bring up control toolbar. The control
toolbar can be used to control the selected camera.
Place the cursor over each button to view tooltips for
the button. If the control toolbar is downsized, you can
move the toolbar left or right by scrolling the mouse
wheel.

. @ (PTZ Control): If the camera supports PTZ control,
the camera's PTZ can be controlled.

. (Remote Control): Directly remote controls the
HDMI encoder image using a keyboard or mouse.

. (Fisheye Dewarping): Dewarp the fisheye camera
image.

. (Self-adjusting Video Mode): Allows you to self-
adjust the video mode.

« #3 (Color Control) : Adjust the brightness, contrast,
saturation and color of the current video. Click C» to
reset all changes and restore the image to original
settings.

This setting can be applied to the videos in IDIS
Center program as well as videos of devices.
- 1] (Image Effect): Applies image effects.

« @& (Zoom): Zooms the video.

. (Camera Sequence): Starts or stops layout
sequence.

+ @/ 8 (Listen/Talk): Receives audio from the device
or sends audio to the device (Not all devices support
audio).
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. / (Alarm-Out On/Off): Turns on or off the
alarm-out connected to camera devices. Alarm-
out connected devices can be configured in each
camera's Edit Device setting.

. (Text-in Viewer): Brings up text-in viewer window.
Turns the title bar of a camera to blue when a text-in
event is detected.

Only supported when text-in event is detected.

. (Instant Playback): Activates the Instant Playback
for the section with the recording information.

- @ (Panic Recording): Starts or stops panic recording.
When panic recording is in progress, a panic recording
icon will be displayed on the upper right corner of the
camera screen.

« (#) (Google Maps): This feature is only supported with
vehicular DVRs/NVRs.

+ A (Speed Graph): This feature is only supported with
vehicular DVRs/NVRs.

« @ (Vehicle Info): This feature is only supported with
vehicular DVRs/NVRs.
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Live Screen Menu

Select a camera screen and right-click to bring up the
screen menu. The screen menu can be used to control
the selected camera.

- Fisheye Dewarping: Dewarp the fisheye camera
image.

- Instant Playback: Activates the Instant Playback for
the section with the recording information.

+ Playback History: Saves 8 instant playback history
in maximum for each camera device and plays the
history.

- Play 30 Seconds/180 Seconds Before: Activates
the Instant Playback of images from 30/180 seconds
before.

» Misc.: Sets the Instant Playback options.



Play Recorded Data: Displays the recorded image of
the selected screen on the play tab.

PTZ Control, Self-adjusting Video Mode, Color

Control, Image Zoom, Listen, Talk, Panic Recording:

Functions identically to the corresponding buttons in
control toolbar.

Camera Sequence Monitoring: Allows you to
move, start, stop, pause and exit the camera
sequence monitoring (supported only for sequence
monitoring).

Image Processing: Applies image effects.

Alarm Out: Activates or deactivates alarm output.

Text-In Viewer: Brings up text-in viewer window.
Turns the title bar of a camera to blue when a text-in
event is detected.

Only supports when text-in event is detected.

NVR Listen/Talk: Receives audio from the NVR device
or sends audio to the NVR device.

Audio File List: Controls(play/stop) audio file
included in the device (only available for devices
which support audio alarm file).

Audio Broadcast: Broadcast audio to all devices in
the current Live tab.

MultiStream: Desired stream can be selected if
multi-stream mode is enabled for the live video of the
device.

Hotspot: Set the selected camera screen as hotspot
screen.

Event Spot: Set the selected camera screen as event
spot screen.

Map Event Spot: Sets the selected screen as map
event spot screen.

VA Overlay: Displays video analysis data over the
monitoring video.

Draw Motion Block: If a motion detection event
occurs on the selected camera, the part of the screen
where motion is detected is displayed as a red block.

Only supports network video servers.

Aspect Ratio: Sets the aspect ratio of video output.
- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.

- Fit to Screen(Aspect ratio): Resizes video to
camera screen while maintaining original aspect
ratio.

Part 5 - Operation

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.

- Half Size (x0.5) - 4 Times Bigger (x4): Displays the
camera videos in the selected size based on the
original size of the video.

The menu is activated only when there is sufficient
space to display the camera video in the selected
size.

Up, down, left, and right part of the video may be
v cropped depending on size of camera screen. When
using Zoom, Hotspot, Event Spot, Show Motion

Block features, aspect ratio of camera screen does
not apply and original ratio is applied.

still Image: Saves the current frame of the video on
the screen as an image file in actual size.

Browser: Sets the selected screen as the browser
screen.

Stream Information: Shows the stream information
of the selected camera.

Device Information: Shows the device information of
the selected camera in sub-items.

Remove: Terminates current connection.
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PTZ Control

Click on 88 (PTZ Control) button in the control toolbar
to bring up PTZ control toolbar. The buttons on the PTZ
toolbar can be used to control PTZ. Some features may
not be supported depending on the PTZ camera model.

& (Directional control): Shows or hides
(Directional control panel). Click on the arrow keys
in the Directional Control Panel or drag the camera
screen to control the directional movement of PTZ
camera.

[ (Slingshot): Controls Pan-Tilt to move the user's
point to the center of the screen.

Only certain network camera models are supported.

(Area Zoom): Specifying a certain area on the
image to zoom in the selected area. Dragging the
mouse specifies the area, and the magnification is
displayed on the drag area. Refer to PTZ Area Zoom /
Area Zoom History on page 65 for details.

(Area Zoom History): Displays the area zoom
history. Refer to PTZ Area Zoom / Area Zoom History
on page 65 for details.

(PTZ Manual Control): Allows camera control by
manually entering pan, tilt, zoom and focus values.

@® O (Zoom in/out): Zoom in and out of current
video.

® © (Focus far/near): Adjust camera focus to far or
near.

® @(Open/close aperture) Open or close aperture
of camera lens.

E 7] (Set Preset/ View Preset): Set or view presets.

&} (Auto-focus): When the camera loses the focus
after zooming in or out, click the auto-focus button to
adjust autofocus.

Only certain network camera models are supported.
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« P& (Focus/Lens/PTZ reset): Initializes the focus/lens/
PTZ settings according to the camera type.

« & (Autorun on/off): Moves the camera to the preset
position at regular intervals.

. (Advanced menu): Controls the advanced
features supported by the camera. For more details
on advanced features, refer to the PTZ camera's
operation manual.

+ X (Close): Closes PTZ mode and returns to control
toolbar.

PTZ Preset Control

Sets the current camera position as a Preset to quickly
move the camera to the preset position.

On the camera screen, move the PTZ camera to the
desired direction.

Click E (Set Preset) on the PTZ toolbar to bring up
Set Preset window. Enter a name for the preset and
click OK to save the current position as the name
just entered.



Click 7] (View Preset) on the PTZ toolbar to bring
up View Preset window. Select the desired preset to
move the PTZ camera to the preset position.

ePTZ Control

Controls Pan, Tilt, and Zoom function more accurately.

Control Pan, Tilt, and Zoom function. Dragging the
mouse, the size of dragging indicates the speed of PTZ.

- Left button drag: Left/Right (Pan control), Up/Down
(Tilt control)

+ Right button drag: Zoom control

Part 5 - Operation

Slingshot

Controls Pan-Tilt to move the user's point to the center
of the screen.

Press [ (Slingshot) in the control toolbar and click any
point of PTZ camera pane to move anywhere you want.
Dragging the mouse zooms the selected part of the
screen.

PTZ Area Zoom / Area Zoom History

Drag the mouse over the image to draw the specific
area to zoom in. The area zoom history is displayed in
thumbnail formats.

This feature is only supported with some models of
¢ camera.

Click the
and drag the mouse over the image to zoom in the

(Area Zoom) button on the control toolbar,

selected area.
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Clicking the
previous area zoom history in a thumbnail list as the

(Area Zoom History) button displays

following image. Click a thumbnail to locate the camera
to the selected position.

Hovering the mouse over each item displays the zoom
magnification value on the thumbnail.

« Sort by distance: Sorts the items in an ascending
order by zoom magnification value. Disable to sort by
latest.

+ Close after goto item: Closes the area zoom history
window after item selection and camera relocation.

- Delete All: Deletes all of items.

PTZ Manual Control

Clickthe  (PTZ Manual Control) button on the control
toolbar displays the following window. The user can
manually enter pan, tilt, zoom, focus values to control
the camera. Each specific position can be saved in the
list and selected to move the camera position.
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Absolute Position

. (Refresh): Displays the camera's current pan, tilt,

zoom and focus values.

« Go To: Moves the camera to the position of entered
pan, tilt, zoom and focus values.

- Get Position: Adds the camera's current pan, tilt,
zoom, focus values as one fixed position to the list.

+ Go To: Moves the camera to the selected position
from the list.

- Edit: Edits the name or each pan, tilt, zoom, focus
value of the selected position from the list.

PTZ Al Tracking

Select PTZ Al Tracking and configure PTZ Al Tracking
settings. With PTZ Al Tracking event enabled, an event
occurs and tracks the moving object(or designated
object) when motion is detected in the video.

+ Object Selection Mode: Selects to track objects of
supported types by specifying them.

- Tracking Stop: Stops tracking the selected object in
Object Selection Mode.

+ Auto Tracking On/Off: If movement is detected in
the video, the moving object is tracked.

+ Run Auto Tracking Now: Turns on Auto Tracking
and starts tracking immediately.



Remote Control

For the live image with the  icon on the OSD, press
(Remote Control) in the control toolbar to bring up the
Remote Control toolbar, and to check the status through
the OSD and use the control buttons.

. /  (Input Device Status): Displays the input
device in action.

. (Disable Remote Control): Disables the remote
control.

. (Initialize Mouse Cursor Position): Move the mouse
cursor to the top left position.

Fisheye Dewarping

Press (Fisheye Dewarping) in the control toolbar to
bring up the fisheye dewarping toolbar. The buttons
on the fisheye dewarp toolbar can be used to dewarp
fisheye image.

The mount type set in the device is a default.

Part 5 - Operation

(Mount Type): Choose a position that the camera
is mounted. The available Screen Type changes
depending on this setting.

(Image Ratio): Select the proper image aspect
ratio.

(Layout): Select the layout, Main View and Main +
1~7 panes mode.

(Panoramic): Select the panoramic mode.

(Selection Mode): Drag and drop the area in the
main view screen.

(Spot Mode): Move and select the area with the
dewarp finder in the main view screen.

(Drag and Drop): Move and copy the main view
and camera pane.

(Main PIP): Shows or hides PIP screen.

PIP stands for Picture in Picture, and it refers to the

small screen displayed within the bigger screen.

3 (ePTZ): Control Pan, Tilt, and Zoom function.
Dragging the mouse, the size of dragging indicates
the speed of PTZ.

- Left button drag: Left/Right (Pan control), Up/
Down (Tilt control)

- Right button drag: Zoom control

(Auto Pan): Set to pan the camera automatically.
+,- for direction and numbers for speed.

] (Load/Save Preset): Load the saved preset of
fisheye video control and save the current fisheye
video control as preset.

(> (Display Source Image): Cancel all changes and
restore image to original.
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Smart UX Quick Control

Combine the keyboard and mouse in the video, and you
can quickly control video enlargement, dewarping, and
PTZ without changing the mode of a specific function.

+ Quick Zoom

- Ctrl + Mouse left button drag (Original Image):
Zoom in the area selected by the mouse drag.

- Ctrl + Mouse left button drag: Moves the zoomed
in image to the position where the mouse drag
moves.

- Ctrl + Mouse wheel click: Exits the zoom image view
and returns to the original image.

- Ctrl + Mouse wheel scroll: Zoom control
+ Quick Dewarping

- Ctrl + Mouse left button drag (Original Image):
Dewarps the area selected by the mouse drag.

- Ctrl + Mouse left button drag: Pan/Tilt control in the
mouse drag directions.

- Ctrl + Mouse wheel click: Exits the dewarping image
and returns to the original image.

- Ctrl + Mouse wheel scroll: Zoom control
- Ctrl + Mouse right button drag: Zoom control
+ Quick PTZ

- Ctrl + Mouse left button drag: Pan/Tilt control in the
mouse drag directions.

- Ctrl + Mouse wheel scroll: Zoom control
- Ctrl + Mouse right button drag: Zoom control

- Ctrl + Shift + Mouse left click/drag: Move the image
to the position where you click becomes the center,
or move the image following the mouse drag.

« Instant Playback
- After selecting a pane, click I: Easy Play.

- After selecting a pane, Page Up/Down: Moves to
the previous/next playback section.

- Wheel scroll on the or during the instant playback:
Jog play is performed according to the direction of
wheel scroll input.

- (Ctrl +) J: Decrease the playback speed.
- (Ctrl +) K: Reset the playback speed.

)

)
- (Ctrl +) L: Increase the playback speed.
- (Ctrl +) .: Executes high-speed reverse playback.
)

- (Ctrl +) ,: Executes high-speed playback.
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Recorded video playback control

By combining the keyboard and mouse in the recorded
video, you can quickly control the playback of the
recorded video without switching the mode of a specific
function.

+ Mouse

- It moves to the previous/netx video by the specified
time interval when wheel scroll is input in the
previous/next frame widget.

- The jog function works when wheel scroll is input
from the play button.

- Playback is controlled in the shuttle lock state when
wheel scroll is input in the shuttle widget.

- Playback stops when you click the right mouse
button on the shuttle widget.

- The shtuule lock is released and playback stops
when you click the middle mouse button on the
shuttle widget.

- The recording section moves left/right when
pressing Shift + wheel scroll in the timetable
widget.

- The recording section is enlarged/reduced when
pressing Ctrl + wheel scroll in the timetable widget.

- Hotkey
- Ctrl + Space: Controls play/stop.

- Ctrl + Shift + Space: Controls play/stop of all
cameras included in the tab.

- Ctrl + T: The time shift panel pops up.

- Ctrl + Home: Moves to the beginning of the video.
- Ctrl + End: Moves to the end of the video.

- Ctrl + J: Decrease the playback speed.

- Ctrl + K: Reset the playback speed.

- Ctrl + L: Increase the playback speed.

- Ctrl + ,: Executes high-speed playback.

- Ctrl + .: Executes high-speed reverse playback.

- Ctrl + left/right keyboard button: Moves to the
previous/next frame.

- Shift + left/right keyboard button: Moves to the
previous/next video in 1 minute increments.

- Alt + left/right keyboard button: Moves to the
previous/next video in 10-minute increments.
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Self-adjusting Video Mode Zoom In
Press (Self-adjusting Video Mode) in the control Press @ (Zoom in) in the control toolbar to zoom in on
toolbar to set or preset the video mode for each the current video.

daytime/nighttime.

« @ (Slider): Adjust magnification.
+ The preset includes Natural, Vivid and De-Noise. Magnification can also be adjusted using the mouse

scroll wheel.
« The Custom allows setup for each value. The values

include Sharpness, Contrast, Colors and Brightness. + [k (Actual Size Zoom): Enters Actual Size Zoom
mode. In Actual Size Zoom mode, the video is zoomed

in based on actual size of the video regardless of the
size of camera screen or magnification.

+ [2] (Zoom Finder): Shows or hides PIP screen.The
square of PIP screen displays the zoomed area.

« When this feature is activated, the setup window is
overlaid, and the image is displayed in the 1x1 format.

- PIP stands for Picture in Picture, and it refers to the
small screen displayed within the bigger screen.
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Image effect

Click on ] (Image effect) on the control toolbar to
bring up image effect control toolbar.

@ (Blur): Softens the image.

/\ (Sharpen): Sharpens the image.

[4] (High-Boost): Enhance image clarity by increasing
brightness and sharpness.

. (Histogram Equalization) : Makes image more
natural by adjusting brightness.

+ B (Edge Detection): Detect outline in the image.

+ (» (Revert): Cancel all changes and restore image to
original.

. These settings are only applicable to images of
IDIS Center program and do not apply to images of
devices.
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Instant Playback

Press Instant  (Instant Playback) on the control
toolbar and select a playback time on the popup
menu to activate Instant Playback for the section with
the recording information.

Hovering the mouse cursor over the screen allows you
to use Exit, Bookmark, Play, and Forward/Backward
buttons.

Using the left/right arrow buttons and PageUp/
PageDown buttons allows moving the playback point.
Select reverse playback and slow playback from the
context menu of the image.

+ Hotkey (Ctrl + Hotkey can also be used.)

- J/K/L:Decrease /reset/ increase the playback
speed.

-, Executes high-speed playback.
- .. Executes high-speed reverse playback.



The status of playback appears on the camera title bar.
Clicking the inverted triangle image beneath the
camera title bar displays a thumbnail image. When

the thumbnail image is enabled, hovering the mouse
cursor on the camera title bar displays the image of the
corresponding site.

Clicking a specific point on the camera title bar moves
to the corresponding site.

Video Analytics

Select a monitoring video and click the right mouse
button to see the display menu. Select VA Overlay from
the display menu to activate the menu according to the
current video analysis type.

People Counting

Selecting People Counting displays real-time In/Out
and occupancy information over the selected video.
Select Count Adjust to change the In/Out information
displayed over the image.

If the occupancy exceeds the set limit, check the limit
occupancy event.

Part 5 - Operation

Queue Management

Selecting Queue Management displays queue
information (the number of people, waiting time) for
each area over the selected video.

In the case of Queue Management, checking Exceed
People Limit and Exceed Time Limit events is available.

Heat Map

Selecting a Heat Map live icon displays a heat map
image over the selected video.

Select options of Heat Map live to change a heat map
image setting (image spectrum color, transparency,
image interpolation option).

Queue monitoring / swarm detection / social

distance violation / mask rule violation
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Selecting queue monitoring / swarm detection /
social distance violation / mask rule violation displays
the set image analysis area.

Up to 5 areas are displayed for queue monitoring.

If the set limit is exceeded, an event is raised and the
area of the offending object is highlighted.

Pixel Counter

Displays the pixel information in the selected area in
the image. The number of pixels of the object's size as
the distance can be calculated with the constant-sized
object.

It provides quantitative information about object
recognition by specifying the area of a specific type of
object and measuring the density of the pixel (number
of pixels per unit length). Go to View > Pixel Counter.

It is displayed a notification pop-up as shown below
\/ running the pixel counter. It provides how to use the

pixel counter and quick control shortcuts.

- The information provided by the pixel counter is
shown below.
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Width and height pixels
Total pixels within the area

The pixel coordinates of the upper left corner of the
area

Area width and height ratio to pane (UV coordinates)
Pane-to-area width ratio

UV coordinates of the upper left of the area

UV coordinates represent the minimum coordinate
as 0 and the maximum coordinate as 1. The upper

left is represented by (0, 0), and the lower right is
represented by (1,1).



Live Network Monitor

Selecting Live Network Monitor from the menu
displays real-time bandwidth (network traffic) for each
device. 16 devices are supported in maximum, and
select a legend to check the specific device only.

Text-In Viewer

Shows text-in data live.

Click @ (Text-In Viewer) in the Control Toolbar to bring
up Text-In Viewer window.

Turns the title bar of a camera to blue when a text-in
event is detected.

Click on the title bar of the Text-In Viewer window to
bring up text-in popup menu.

Save As...

Time Range ¥

« All Attach: Gathers Text-in Viewer windows into one
panel.

- Save As...: Saves text-in data as a text file(.txt).

Part 5 - Operation

+ Time Range: Set the duration in which text-in data is
displayed when text-in event is detected. Text-in data
can be checked in the text-in viewer window during
the set duration after text-in event has occurred.

Only supported when text-in event is detected.

Google Maps

Click () (Google Maps) on the Control Toolbar to load
the Google Maps panel as a popup.

This feature is only supported with vehicular DVRs/
Vs

If the video contains GPS info, the vehicle's location
(@) and direction of travel (4) are shown on the map.
“Map” and "Satellite" (Terrain On/Off) are Google Maps'
display modes.

When checking the vehicle's location and direction
V of travel, the vehicle's speed is shown on the Speed
Graph panel.
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Speed Graph Vehicle Info
Click i (Speed Graph) on the Control Toolbar to load Click @ (Vehicle Info) on the Control Toolbar to load the
the Speed Graph panel as a popup. Vehicle Info panel as a popup.

This feature is only supported with vehicular DVRs/ This feature is only supported with vehicular DVRs/

\/ NVRs. ¢ NVRs.

<No name:>

If the video contains GPS data, the vehicle's speed is Vehicle information is shown if contained in the video
shown on the Speed Graph. The speed is shown in the file.

middle of the graph. The red, vertical line in the middle

indicates the vehicle's current location.

Right-click on the Speed Graph panel to configure

graph type, graph unit, GPS info display, and HD output

settings.

When checking the vehicle's speed, the vehicle's
\/ location and direction of travel are shown on the
Google Maps panel.
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Live Zoom Pop-up

This feature displays the region of interest (ROI) of the
video in a separate pop-up.

Select the Live Zoom Pop-up from the Live menu or
press F9 to start.

It interacts with the selected pane. When the pop-up
is closed or a different camera pane is selected, the
previous camera pane's status is saved and restored
when the pop-up is reassigned.

It supports zoom-in and zoom-out functions.

It also supports fisheye camera dewarping (client-
side dewarping). The fisheye camera dewarping pane
displays the original image while the zoom pop-up is
selected.

+ Mouse Control

- Mouse M-button: Reset zoom (switch to original
image)

- Drag and release the mouse pointer on the original
image: Run ROI Spot

- Drag the mouse pointer: Move the ROI
- Scroll the mouse wheel: Control zoom in/out

- Drag the mouse R-button up/down: Control fisheye
dewarping zoom in/out
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Map Control

Controls the map using the control toolbar and screen
menus.

Control toolbar

Select a map and place the cursor over the map to bring
up control toolbar. The control toolbar can be used to
control the selected map. Place the cursor over each
button to view tooltips for the button.

+ 4w (Previous Map, Next Map): Go to previous
or next map after going to another map by a link or
connecting to another map by selecting a map in the
map list and dragging & dropping to the current map
screen.

» AF (Auto Focusing): Zooms in on the zone where the
device is located on the map when an event occurs.
For more details on auto focusing settings, refer to

Map on page 46.

When events occur simultaneously on multiple

devices, the canvas is expanded so that all the
devices are displayed. If events are detected
sequentially in different devices, the auto-focus
will switch to latter event after the set duration has
passed.

+ 4% (Focusing Event): Designate an event to auto-
focus on.

« [ (Actual size): Shows the map in actual size of
canvas.

+ [o] (Zoom Finder): Shows or hides PIP screen. The
square of PIP screen displays the zoomed area. If Auto
is selected, PIP screen is only displayed when canvas

is zoomed in. 75
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+ @ (Zoom slider): Changes magnification of the + If set as Auto or On;

canvas.
Map Monitoring

Example of magnification finder settings

. If set as Off;

Map Monitoring

Event Detected

!

Event Detected

!

Auto Focusing

Auto Focusing
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Map screen menu

Select a map screen and right-click to bring up the
screen menu. The screen menu can be used to control
the selected map.

Reload

Auto Focusing

Actual Size (x1)
Zoom Finder r

Zoom In L4

Save Still Image...

+ Previous, Next, Auto Focusing, Actual Size (x1),
Zoom Finder, Zoom In: Functions identically to the
corresponding buttons in control toolbar. For more
details, refer to Control toolbar on page 61.

- List: Shows the list of maps connected previously or
to connect to next. Select a map on the list to go to
the selected map.

« Reload: Refreshes connection to the current map.

+ Focusing Event, Focusing Duration: Set focus events
and focus duration for auto-focus feature.

- Save Still Image: Saves the currentimage on the
screen as an image file at its original size.

« Remove: Terminates current connection.
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Live Popup

When an event is detected during map monitoring,
a live screen is displayed as a popup according to the
settings in Map Editor.

Live popup list displays the list of current popup
screens on IDIS Center .

Popup screen

Select a screen and place the cursor over the screen

to bring up control toolbar. The control toolbar can be
used to control the camera. Place the cursor over each
button to view tooltips for the button.

Right-click on the pop-up screen to bring up popup
screen menu. The menu can be used to change popup
screen settings or control the camera. Menus related to
camera control have identical features as Live menu. For
more information, refer to the Live Screen Menu on

page 62.
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Live popup list

Click on the arrow button at the upper right corner to
bring up live popup menu. The menu can be used to
change popup screen settings.

Layout 4
Monitor L4
Ignore Live Popup L4

Disable Time Out

Remaove all...

« Layout: Changes layout of popup screen. Select Use
Single Live Popup to display a single popup on the
screen.

+ Monitor: When using dual monitors, the monitor for
displaying popup screen can be selected.

« Ignore Live Popup: When a duration is entered, live
popup feature is suspended for the duration entered
regardless of Live Popup Duration entered in event
activities in Map Editor.

- Disable Time Out: Closes popup screen manually
regardless of the defined popup screen duration.

- Remove All: Removes the entire list.

Browser

It's possible to launch registered browsers. It must first
be registered to the administration service to launch a
browser. For more details on browser registration, refer
to the following section.

In the Browser list, select a browser you wish to launch.
Then, drag & drop the selected browser on the live
screen using your mouse. This launches the selected
browser.
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Browser Registration

Select Settings in the System menu and select the
Device menu.

On the Site panel, click on Browser, then click on
the 4 button at the bottom of the Site List panel on
the right. Add Browser window will be shown.

+ URL Setup: Enter the name and address of a URL
(Uniform Resource Locator).

- Fit to Pane: Adjusts the web page to fit the size of the
browser screen.



- Enable Popup: Allows popup pages.
+ Popup All New Window: Displays the web page's
popup screens as separate screens.
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Intercom

By connecting the intercom device, you can monitor
video and make calls, and control the opening and
closing of doors.

Setting Call Request Receiving

When the intercom call is received, when an event is
detected, a pop-up screen appears according to the
Instant Event - Intercom - Call Request Receiving.

Intercom

« Not Use: Do not specify the setting when a call
request is received.

- Notification: Display the intercom notification popup.

+ Intercom Popup: Display the intercom popup.

Intercom Notification Popup

A pop-up screen is displayed when a call request is
received. The device name, site (group) name, and call
request time are displayed.

« Click answer call button: End notification popup and
display the intercom call popup.

+ Clicking the left mouse button on the reject call
button: End the intercom notification popup.

+ Middle/Right Mouse Click on Reject Call Button:
Reject the call request without exiting the intercom
notification popup.

« In the following cases, the pop-up automatic
shutdown function operates.
- When a call request timeout occurs while
receiving a call request

- 10 seconds after receiving a call request
cancellation while receiving a call request

- 1 minute after receiving end of call request
due to preemption of VOIP call

« If the auto-shutdown count has started,

clicking the pop-up will cancel the count. 79
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Intercom Missed Call Request Notification Popup

A pop-up is displayed per device upon receipt of a
missed call request event. The device name, site (group)
name, and call request time are displayed.

+ Click the recorded video play button (including the
play button in the list): Plays the recorded video of
the missed call request time.

- Drag the recorded video playback button/playlist
item and drop it on the camera pane: Plays the
recorded video at the time of the missed call request.

+ Click the Normal/Extended mode switch button: If
there are multiple missed call request records, you can
switch the mode and view the missed call request list.

Intercom Call Popup

You can run the pop-up of forward call mode through
the Call button on the control toolbar of the intercom
camera pane connected to the Monitoring tab or the
Call item in the context menu.

<Be ore Ca”>
0
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<Calling>

(8] o

@ Device name: Shows the device's name.

@ Site/Group name: Shows the name of the site or
group.

© Volume control: Controls the system volume and
the mute of the audio input/output device.

O Unlock Door button: Click and hold to unlock the
connected door.

O Reject button

- Click left mouse button: End the call and exit the
pop-up.
- Click right/middle mouse button: Stop the call.

@ Call button: Respond to the intercom call request or
request a call.

@ Calling time: During a call, the elapsed call time is
displayed.

O Close button

- Click left mouse button: End the call and exit the
pop-up.
- Click right/middle mouse button: Stop the call.



« In the following cases, the pop-up automatic
shutdown function operates.
- 10 seconds after the call request timeout
while receiving a call request

- 10 seconds after receiving a call request
cancellation while receiving a call request

-1 minute after receiving end of call request
due to preemption of VOIP call

- If you do not click the OK button in the
timeout dialog box displayed every 5
minutes when intercom call function is
occupied, after 10 seconds

+ If the auto-shutdown count has started,
clicking the pop-up will cancel the count.

- End/Reject button: Ends or rejects the
intercom call and closes the pop-up. (The

pop-up does not close when clicking the right/

middle mouse button.)

« Unlock Door button: Click and hold to unlock

the connected door.
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Recorded Video Playback

Recorded videos can be search and played.

Playback of videos recorded on the device and IDIS
Center System are supported on up to 4 Play panels.
If a Play tab doesn't exist in the panel tabs, you can
add them by selecting New Tab in the System menu
and clicking Play.

In the panel tabs, click the Play tab.

In the Site list, select a site you wish to connect to.
Then, drag & drop the selected site on the playback
screen using your mouse.

The recorded video of the each camera will be
displayed on the screen.

+ You can select and move a camera playback to
v a desired position on the Play screen without
pausing playback by selecting the camera

being played and moving it using drag & drop
with your mouse.

+ Ifalayout is registered, you can select a desired
layout from the Layout list and drag & drop
on the Play screen to play videos using the
selected layout.

+ Monitoring or playing 2 or more camera videos
on a PC with a low specification may cause the
performance of IDIS Center system to drop.
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Play recorded videos using Panel Toolbar, Timetable, Control Toolbar and Screen Menu.

Panel Toolbar

Video recording can be played and searched using the toolbar at the bottom of the panel.

Toolbar may vary depending on the model and version of the devices connected. Some features may not be supported.

or

X / [€) (Event Search/Time-lapse Search): Switch search modes between Event Search and Time-lapse Search.

- [BY (Search Filter): Sets search conditions for event search. For more information on search condition, refer to the
devices's operation manual.

« B (Calendar): Search videos from specific dates. When a date is selected, recorded data of the selected dates are
displayed on the timetable. Dates that have video recordings are activated.

+ [ (Move To): Search videos from a specific time.

- Go To: When the time setting window appears, enter the desired time of the video recording to go to the entered
time. Selecting Load Adjacent Frame skips to the nearest time in the video recording if there are no video
recordings for the desired time.

- Move First: Go to the first video among the recording data on the timetable.

- Move Last: Go to the last video among the recording data on the timetable.
- [ (Additional Menu): Show menu.

- Data Source: Selects the data source to be searched.

Search on Local Search video recordings in the primary storage device of DVR.

Search on Archive Search video recordings in the backup storage device of DVR.

Search video recordings in the storage device that was used in other DVR.

Search on Other External Storage Search may not be supported depending on DVR's specifications and
\/ version.

- Overwrite Protection: Checks the recorded video with overwrite protection in the device.
- Add Bookmark: Bookmarks the recorded video.

- Remote Site Panel: Shows or hides a site list in the floating panel or full screen. Not every panel supports this
function.

- Text-In Panel: Shows the Text-In panel.

- Select Segment: If more than one video exists in the same timeframe due to time overlap caused by changing
the time of the DVR, a desired segment can be selected.

Only supports DVR that provides a hourly timetable.

- |B (Export Video File): Save video recording as a proprietary viewer file(.exe) or an AVI file(.avi).
- Save Still Image: Saves the current frame of the video on the screen as a image file in actual size.

- Export Image/Print Image: Save or print current image on the screen.
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- Export Panorama Screen: Save the image on the screen of all panels.
. (Bookmark): Allows you to bookmark the selected recorded video, play or remove the added bookmark.

. (Event on Play): If an event recording exists during a video recording playback, a list of events are shown. Double-
click on the event on the Event List to play the event recording.

Z (Thumbnail Search): Shows still images of videos recorded during event and pre-event in the Play panel.

. (Text-In Panel): Displays thte Text-In panel. The Text-In panel shows the text-in data of the devices currently
connected to the IDIS Center. If a camera is associated with the text-in device and the video of the associated
camera is displayed on the current Play screen, the text-in data is displayed on the video on the camera screen, too.
You can change the length of time that the text-in data is displayed by using the Live Text-In Time Range setting.
For more details about the Live Text-In Time Range setting, refer to Instant Event on page 44.

- LI (Step Playback): Skips to previous or next video by frame or time. Skip increments can be adjusted by
pressing the arrow between ] and [TS.

- B /2 (Fast Backward/Fast Forward): Plays video recording in high-speed in reverse or normally.

« [0 / I3 (Stop/Play): Stops or plays recorded video of the selected device.

« [ET—5 (Jog shuttle): Adjusts the playback method and speed. Jog shuttle's vertical indicator indicates the
current playback direction and speed. Vertical indicator placement to the right of the center means the video is
being played back in the forward direction. Placement to the left means the opposite. Farther away the vertical
indicator from the center, faster the playback speed. Click and drag the vertical indicator to adjust the playback
speed. Releasing the mouse button returns the vertical indicator to the center and stops video playback. Clicking
the [ (Lock) button and dragging the vertical indicator fixates the vertical indicator in the new position.

+ [E=g== (Jog shuttle): Adjust the playback speed. Vertical indicators on the job shuttle indicates the current
playback speed.

. n / - (Play on Tab/Pause on Tab): Plays or pauses playing recorded video of all devices displayed on the current
screen.

« B (Save to User Layout): Saves current screen layout.

. (Layout): Changes layout. Various layouts can be selected by clicking il
button. You can switch to previous or next camera group by clicking I or [J.

Timetable

In Time-lapse Search Mode, timetable at the bottom of the screen shows recording information of each camera. When
the A at the upper right corner of the timetable is clicked, recording information of all cameras on the screen are
shown. If the ¥ is clicked, only the recording information of cameras selected in the Play screen are shown.

(1] 2]

(3] 4]

Timetable may vary depending on the model of the connected device.

0 Date/time of video Shows time and date of current playback on the timetable. Click the left mouse
playing button and open the time setting window.
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Shows the date and timeframe of the video recording. To move to the previous
or following date and time, click anywhere and drag left or right, or move the
Recording Time mouse wheel while holding down the Shift key on the keyboard. Timeframe can
be magnified by moving the scroll wheel while holding down the Ctrl key on the
keyboard.

CameraTitle Shows the camera's title.

Shows the recording information in minutes or hours.

- Second, Minute interval timetable (Applies to all devices, with exception of
some DVR models)

- Red vertical indicator: Shows time and date of current playback on the
timetable. Click on a desired time, and the first video recording of the
selected time is played.

- Yellow separator: Separates segment where time overlap has occurred. In
this case, the data shown on the right-hand side of the timetable is newer
data. Click the B (Calendar) on the Play panel to go to a desired segment.

- Bar color: Shows the recording mode.

Blue I | Time Lapse Recording

Purple = | Event Recording
Recorded data Yellow Pre-Event Recording
Red

Panic record

|
Faulty recording due to a temporar
Green ] R Y . g. 'p y
disruption in device connection.

- Moves the recorded image by 1 second~1 minute according to the timetable
magnification.

+ Hour interval timetable (Applies certain DVR models)
- Yellow bar: Shows time and date of current playback on the timetable.

- Pink bar/Gray bar: If time overlap has occurred, the video segment currently
shown on the screen is indicated by a pink bar and the video segment not
shown on the screen is indicated by a gray bar. Video segment indicated by a
gray bar cannot be played. To change the segment to play on the screen, click
& (Other Menu) in Play panel.
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If the clock of the IDIS Center system or device is changed to a point in the past, overlapping recordings may be produced,
which is where more than one recording exists at the same point in time. In this case, overlapped recordings have to be
played as separate segments.

1:00 2:00 3:00 4:00 5:00
Segment 1 t t t

Segment 2 f t } |
3:00 4:00 5:00 6:00

For example, making a recording from 1 o'clock to 5 o'clock, changing the system's clock at 5 o'clock to 3 o'clock, and then
continuing to record until 6 o'clock produces two recordings that overlap between 3 o'clock and 5 o'clock. This results in two
segments for the period between 3 and 5.



Event list

In Event Search Mode, event list is displayed at the
bottom of the screen. When searching an SD (SDHC)
memory card, only the events that occurred while SD
(SDHC) memory card recording feature is enabled can
be searched.

If there is an event recording, double-click on the event

on the event list to play the event recording. To see the
following matches, click @8 at the upper right corner
of the event list. Click [Ell, set the time, and select the
event to go to the previous recorded data as the time
you set.

Control toolbar

Select a camera screen and place the cursor over the
camera screen to bring up control toolbar. Place the

cursor over each button to view tooltips for the button.

. (Fisheye Dewarping): Dewarp the fisheye camera
image.

. 98 (Object/Motion Search): Object or motion
changes can be searched in the video recordings of
devices or panic recordings of IDIS Center system.

« @ (Zoom): Magnifies the current video.

- ) (Color Control) : Adjust the brightness, contrast,
saturation and color of the current video. Click C» to
cancel all changes and restore image to original.

. These settings are only applicable to images of
IDIS Center program and do not apply to images of
devices.

] (Image Effect): Applies image effects.

+ @ (Audio playback): If audio is recorded, the
recorded audio is played with the video upon
playback.

Part 5 - Operation

Only supports 1x1 layout.

+ () (Google Maps): This feature is only supported with
vehicular DVRs/NVRs.

« A (Speed Graph): This feature is only supported with
vehicular DVRs/NVRs.

+ @ (Vehicle Info): This feature is only supported with
vehicular DVRs/NVRs.

Play screen menu

Select a camera screen and right-click to bring up the
screen menu.

Image Zoom 4
Image Processing 3
Motion/Object Search

Aspect Ratio b
Still Image 3
Stream Information Tab

Thumbnail Search

Remove L4

- Fisheye Dewarping: Dewarp the fisheye camera
image.

+ Image Zoom: Functions identically clicking to the
corresponding buttons in control toolbar.
- Image Processing: Applies image effects.

+ Motion/Object Search: Object or motion changes
can be searched in the video recordings of devices or
panic recordings of IDIS Center system.

+ VA Overlay: Displays video analysis data over the
monitoring video.

- Aspect Ratio: Sets the aspect ratio of video output.

- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.

- Fit to Screen(Aspect ratio): Resizes video to
camera screen while maintaining original aspect
ratio.

Up, down, left, and right parts of the video may be
\/ cropped depending on size of camera screen. When
using Image Zoom, aspect ratio of camera screen

does not apply and Original Ratio is applied.

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.
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- Half Size (x0.5) - 4 Times Bigger (x4): Displays the
camera videos in the selected size based on the
original size of the video.

The menu is activated only when there is sufficient
v space to display the camera video in the selected
size.

- Still Image: Saves the current frame of the video on
the screen as an image file in actual size.

« Save Text-In Report: Saves the text-in information of
the video as the report.

« Stream Information: Shows the stream information
of the selected camera.

« Thumbnail Search: Shows still images of videos
recorded during event and pre-event in the Play
panel.

« Remove: Terminates connection.

Bookmark

Clicking the il (Bookmark) button on the panel toolbar
allows you to bookmark the selected recorded video.
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Click the (Add Bookmark) button.

Enter the bookmark name and description. Clicking
the Add button bookmark the recorded video.



Clicking a bookmark from the bookmark list displays
the bookmark information at the bottom. Clicking
the |y™ (Play Recorded Data) button displays the
bookmarked video on the Play screen. Clicking

the (Remove Bookmark) button deletes the
bookmark.

Thumbnail Search

E (Thumbnail Search) is clicked in the Panel
Toolbar, still images of videos recorded which belong to
the search filters are shown in the Play panel.

Recording information of the selected freeze-frame is
displayed on the timetable. When user clicks anywhere
on the recorded data on the time table, a freeze-frame
image of the selected time is shown. Use arrow buttons
or a mouse wheel scroll to move to previous/next still
images.

Placing the mouse cursor over the freeze-frame brings
up a popup viewer screen above the freeze-frame.

In the timelapse mode, click on the selected image
again to decrease the time interval of thumbnails. When
the interval is 1 second, a popup menu is displayed to
select the time interval.

« Use Popup Viewer: Supports popup viewer screen.

Filter Settings

Select the [ (Filter Settings) button to configure search
filters. Filters include event search, timelapse search and
meta filtering search.

Part 5 - Operation

+ Event Search: Select more than one event to display
the recorded image of the time when the event
occurred.

- TimeLapse Search: Displays the images according to

the set time interval (4 Hours, 1 Hour, 10 Min, 1 Min,
30 Sec, 10 Sec, 1 Sec). When Use KeyFrame Mode is
selected, only keyframe images are listed.

+ Meta Filtering Search: Displays meta data images

which include data based on certain conditions.
Conditions include object type, accuracy, amount,
color and direction, and these conditions can be
combined by AND or OR for search.
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Motion/Object Search

Clicking the 3 (Motion/Object Search) on the control
toolbar brings up motion/object search panel at the
bottom.

Object or motion changes can be searched in the video
recordings of devices or panic recordings of IDIS Center
system.

for detecting object or motion changes can be set by
dragging the mouse.

the camera screen by dragging the mouse.

3 (Set Ref. Image): Sets current image in the camera
screen as a reference image for detecting object
changes.

A& (View Ref.Image): Shows or hides reference
image as PIP screen.

Setting and viewing reference images only apply to
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object searches.

Find Method: Choose a scan method.

- Motion Search: Compares two consecutive video
recordings and detects the recording that shows
changes in the search area. (e.g.: if a motion is
detected)

- Object Search: Compares changes in the search
area to the reference image and finds videos where
the change occurs and maintains until activation
time. (e.g.: if an object is missing)

- Sensitivity: Set the sensitivity for detecting changes.

Higher values will result in more sensitive detection.

Num of diff. block: Select the minimum block for
detecting changes. The change must be bigger than
the defined number of blocks to be considered as a
change.

Only applies to motion search.

Diff. % to ref. image: Select the minimum ratio

for detecting changes. The change must be bigger
than the defined change ratio to be considered as a
change.

Only applies to object search.

Activation Time: Set the duration that the change
must persist to be considered as a valid change when
detecting changes. A detections that do not last for
the specified duration of time will not be considered
as a change.



Image Zoom

Press @ (Image Zoom) in the control toolbar to zoom in
on the current video.

« @ (Slider): Adjusts magnification.
Magnification can also be adjusted using the mouse
scroll wheel.

» [5 (Actual Size Zoom): Enters Actual Size Zoom
mode. In Actual Size Zoom mode, the video is zoomed
in based on actual size of the video regardless of the
size of camera screen or magnification.

+ [o] (Zoom Finder): Shows or hides PIP screen. The
square of PIP screen displays the zoomed area.

. PIP stands for Picture in Picture, and it refers to the
small screen displayed within the bigger screen.

Part 5 - Operation

Image Effect

Click on L] (Image Effect) on the control toolbar to
bring up image effect control toolbar.
Image effects to the image using each button.

. These settings are only applicable to images of IDIS
Center program and do not apply to images of devices.

+ ) (Blur): Softens the image.

/\ (Sharpen): Sharpens the image.

+ [4] (High-Boost): Enhance image clarity by increasing
brightness and sharpness.

(Histogram Equalization) : Makes image more
natural by adjusting brightness.

+ B} (Edge Detection): Detect outline in the image.

+ (C» (Revert): Cancel all changes and restore image to
original.

Pixel Counter

Displays the pixel information in the selected area in
the image. The number of pixels of the object's size as
the distance can be calculated with the constant-sized
object.

It provides quantitative information about object
recognition by specifying the area of a specific type of
object and measuring the density of the pixel (number
of pixels per unit length). Go to View > Pixel Counter.

It is displayed a notification pop-up as shown below
\/ running the pixel counter. It provides how to use the

pixel counter and quick control shortcuts.
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. The information provided by the pixel counter is
shown below.

+ Auto, Defog, Lowlight: Applies filters and set each
value.

- ROI Spot: Applies filters to the selected area only.

+ High-Boost: Applies high-frequency enhancement
filter.

0 ) r5) Google Maps

Click () (Google Maps) on the Control Toolbar to load

the Google Maps panel as a popup.
« Width and height pixels

This feature is only supported with vehicular DVRs/

« Total pixels within the area v NVRs

« The pixel coordinates of the upper left corner of the
area

+ Area width and height ratio to pane (UV coordinates)
+ Pane-to-area width ratio

« UV coordinates of the upper left of the area

UV coordinates represent the minimum coordinate
¢ as 0 and the maximum coordinate as 1. The upper
left is represented by (0, 0), and the lower right is

represented by (1,1).
P y If the video contains GPS info, the vehicle's location

(®), direction of travel (4), and route (red line "HDP”

site only) can be looked up. "Map" and "Satellite"

(Terrain On/Off ) are Google Maps' display modes.
Smart |mage Filter From Google Maps, click on the vehicle's route (red line)
or select the Vehicle Location () icon and then drag
and drop to see the recorded images of the location on
the screen. (“HDP” site only)

Click on E=8) (Smart Image Filter) on the left bottom
of the recorded image to apply filters to an image
according to the status of the image or purpose. When checking the vehicle's location and direction
V of travel, the vehicle's speed is shown on the Speed
Graph panel.
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Speed Graph

Click i (Speed Graph) on the Control Toolbar to load
the Speed Graph panel as a popup.

This feature is only supported with vehicular DVRs/

\/ NVRs.

If the video contains GPS data, the vehicle's speed can
be looked up on the Speed Graph. The speed is shown
in the middle of the graph. The red, vertical line in the
middle indicates the current playback location.
Right-click on the Speed Graph panel to configure graph
type, graph unit, GPS info display settings.

Click on the Speed Graph panel to see the recorded
images of the location on the screen. (“HDP” site only)

When checking the vehicle's speed, the vehicle's
V location and direction of travel are shown on the
Google Maps panel.

Vehicle Info

Click @ (Vehicle Info) on the Control Toolbar to load the
Vehicle Info panel as a popup.

This feature is only supported with vehicular DVRs/

\/ NVRs.

Part 5 - Operation

Vehicle information is shown if contained in the video
file.

Metadata Chart

Clicking Metadata Chart in the context menu of the
playback screen will display the Metadata Chart panel
in a pop-up screen. For more details, refer to Metadata
Chart Panel on page 153.

This feature is only supported with vehicular DVRs/

¢ NVRs.
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Text-In Report

Text-In search results can be saved as a PDF file report. Click Bl (Search) in the Toolbar at the bottom of the Play Panel

and select Text-In from the popup window.

Search Text-In from  (Search Conditions) to switch to the event search mode like the above. When search is
complete, click (Text-In Report) or double-click on the recorded image with the text-in data from the Play tab and
switch it to 1x1 layout. Right click on the mouse and select Save Text-In Report... to bring up the following popup

window.

Enter text-in information and click Save to save the text-in report as a PDF file.
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Snapshot: Select an image to be included in the report.
Select one of 12 images, ranging from -2 ~ +2 seconds from
the text-in event. You can move left and right using the
horizontal scroll control at the bottom of the list, or control
it with the mouse wheel.

Transaction: Displays the text-in data for the report.

Title, Comment, Footer: Enter the title, comment and
footer of the report.

Options
- Auto close after save: Automatically closes the text-in
report window after saving is complete.

- Use Password: Saves the text-in report as a PDF file with
a password.
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Export Video File

Recorded videos can be saved as a video file. Click on the & (Export Video File) in the Toolbar at the bottom of the
Play Panel to bring up Export Video File menu.

- A-B Export Video File: Set the section of the video you wish to save using the timetable. Select A-B Export Video
File in the Export Video File menu. On the timetable, click the starting point and end point to specify the section
you wish to save. When Export Video File window appears, the video for the selected section can be saved as a
proprietary view file (.exe) or an AVl file (.avi).

- Export Video File: Set the section of the video you wish to save by manually entering the start and end points.
Select Export Video File in the Export Video File menu. When Export Video File window appears, the video for the
selected section can be saved as a proprietary view file (.exe) or an AVI file (.avi).

« Export Text-In Data: Exports the text-in data in a text file (.txt). Set up the range for the text-in data to save.

- Reserved Self-Player: The status of reserved video save can be checked in real time. Select Site in the Reservation
List and click Instant Start, Delete buttons to use this function. Status of reserved save as video tasks can be
refreshed by clicking Refresh.

- Save Still Image: Saves the current frame of the video on the screen as an image file in actual size.
- Export Image: Saves current image on the screen.

- Export Panorama Screen: Save the image on the screen of all panels.

« Print Image: Prints currentimage on the screen.
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Save as a SeIf—PIayer File + Exclude Player: Saves only the video recording
without proprietary viewer.

Saves video recording as a self-player file(.exe). + Notincluding the player reduces the file size and
time to save a video. However, the proprietary

viewer (IDIS player.exe) provided in IDIS Center
software installation folder (\Client\selfplayer)
needs to be run to play the saved video.

« This function may not be supported depending
on device's specifications and version.

« Exclude Audio Data: Saves the recorded data without
the audio data.

- Reservation: The save video function can be reserved.
When a reservation period is set, the video is saved at
the reserved time. If the device is disconnected during
saving and saving fails, the IDIS Center system retries
saving at the selected interval.

+ Use Clip Measurement: Measures the clip size in
advance to determine its capacity.

+ When the data file reaches 2GB or 4GB depending
v on the device, you will be asked to continue saving
by creating multiple files.
+ If a network failure or disconnection occurs during

saving, it is displayed as a list on the reserved
self-player. When the network is restored, it tries

+ From, To: Enter the date and time of the recording you exporting from the point where the saving was
wish to save as video. completed.
- First: Sets date and time of the first video as the start + To temporarily pause saving, press the Stop
point. button, then select Add to Reserved Self-Player

and click Yes. When a saving file is displayed on

- Last: Sets date and time of the last video as the end the list of reserved self-player, select Instant Start

point.

- +1 Minute, £3 Minutes, £10 Minutes, +30
Minutes, £1 Hour: Adds or subtracts the amount
of time from the time currently selected on the
timetable.

« Self-Player, AVI: Select Self-Player.

- Split File Size: Splits and saves the file if the recorded
video data exceeds the set split file size.

to resume saving.

- Save Password: Set a password for playing the video.
When a password is set, the viewer program asks for
password while running.

« Save Keyframes Only: Saves the keyframe only as the
interval you set.

+ Include Text-In Data/ANPR/VA Metadata/Event:
Includes text-in data/ANPR/VA Metadata/Event data
when saving video if the video was recorded with this
data.

+ Include Watermark: Saves the specified
watermark(text or text pattern) with the video.
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File Playback using proprietary viewer

Because proprietary viewer files include its own player
(Clip Player), there is no need to install additional
software for playback. When the file is double-clicked, the
player is ran automatically and the video is displayed on
the screen. The scroll bar at the right bottom of the player
can be used to jump to a specific point of time in the
video. Click B to exit the player.

Go to beginning [« Rewind

Play at normal

Got d
o to en > speed

Rewind by frame > | Fast forward

Play by frame

Part 5 - Operation

:If current layout includes a video stored in the

previous camera group, the panel switches to the

previous camera group.

[:]: Changes layout in the orderof4 — 8 - 9 - 16
- 20 - 25 - 1+32.

: If current layout includes a video stored in the
next camera group, the panel switches to the next
camera group.

: Properties of player can be set.

Fisheye Dewarping 4

Print
Frame Info
Image Processing

Play Speed Centrol

Drawing Mode »
Screen Size 3
Aspect Ratio 3
05D Setup...

v Enable Audio

v | Anti-Aliasing Screen

v | Show Text-In
Continucus File Play

ous File

ext File
File List 3
Repeat Playback
Check Fingerprint

- Fisheye Dewarping: Controls Fisheye Dewarping.
- Print: Prints current image.

- Frame Info: Shows information about the current
image, including the screen number, camera title,
time of recording, recording mode, file size and
resolution.

- Image Processing: Adjust brightness or apply image
filters such as soften or sharpen.

Only supports 1x1 layout.

- Play Speed Control: Changes speed of Play, Fast
Forward and Rewind.

- Drawing Mode: Select drawing mode. If the screen
is not displayed correctly or not displayed at all,
the problem can be resolved by changing Drawing
Mode.

- Screen Size: Select screen size of the player.

- Aspect Ratio: Change the aspect ratio of the video
displayed on the screen.
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0OSD Setup: Change the basic settings of the video
displayed on the screen.

Enable Audio: If audio was recorded with the video,
enabling this option plays audio upon playback.

Only supports playback in 1x1 layout.

Anti-Aliasing Screen: Removes stair step (block)
artifacts in magnified videos upon playback. If the
playback is slow due to insufficient processing power
of the PC's CPU, disabling the Anti-Aliasing option
can improve overall speed.

Show Text-In: Displays text-in data if the video

was recorded with text-in data. In the single-screen
layout, text-in data is displayed with images on the
screen. In multi-screen layouts, click the right mouse
button on a camera screen and then a text-in menu.

Continuous File Play: Plays the files that compose
the split file successively. For example, if video is split
to 3 files of abc_01.exe, abc_02.exe and abc_03.
exe when it is saved, you don't need to play each file
one by one manually. abc_01.exe, abc_02.exe and
abc_03.exe files will be played successively when
you play the abc_01.exe file.

Move to Previous File: Moves the previous file from
the currently playing file or the file to be played
when playing a split file.

Move to Next File: Moves the next file from the
currently playing file or the file to be played when
playing a split file.

File List: Lists the files that compose the split file in
sequence. Selecting a file from the list moves to the
selected file.

Repeat Playback: Playback again after playing the
recorded file.

Check Fingerprint: Checks the validity of the entire
file segments.

- [E]: Save the current image.

Save as Image
Save as Image (Actual Size)

Save as Clip-Copy
Save as Yidea

Clip-Copy Log
Save Frame Info

- Save as Image: Save current screen as image file.

- Save as Image (Actual Size): Save current screen as
image file in actual size.

Only supports 1x1 layout.

- Save as Clip-Copy: Saves video of desired time
range as an executable file.

- Save as Video: Save specific part of the video as AVI
file(.avi).

- Clip-Copy Log: Saves the clip copy log information
as a text file. The user information about Save As
Clip Copy will be logged as Internal-Copy.

- Save Frame Info: Saves the frame information as a
CSVfile.

: Magnifies or shows screen in actual size. When
maghnified, you can click on the magnified screen and
move the cursor to determine the position of the
magnified screen.

Only supports 1x1 layout.

: Shows screen in full screen.

© . © :Displays at the lower right corner of the
player. When it is confirmed that the video has not
been altered, the @ icon is displayed. If the video
has been altered, € icon is displayed and playback is
stopped.
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- Fisheye Dewarping

Mount Type: Chooses a position that the camera
is mounted. Choose from Auto, Wall, Ceiling and
Desktop. The available Screen Type changes
depending on this setting.

View: Displays the original fisheye dewarping video.
Choose from Single, Quad and Panoramic view.
When ePTZ is on, you can control Pan, Tilt and Zoom
by clicing the left/right mouse button. The Main PiP
is selected as a default.

Filter: Choose a filter to improve the resolution
Choose from Nearest, Linear, Cubic and Linear, NN
OnPTZ filters.

ePTZ: Controls Pan, Tilt and Zoom function.
Dragging the mouse, the size of dragging indicates
the speed of PTZ. The left button drag controls Left/
Right (Pan) and Up/Down (Tilt). The right button
drag controls Zoom.

Main PIP: Displays PiP (Picture in Picture) view to
select the area easily in the main view screen.
Display Source Image: Cancels the adjustment and
reloads the original image.

+ The minimum CPU requirement for running the
\/ player is 800MHz Pentium Il (Intel Pentium Dual

Core 2.2GHz recommended). If the CPU does not
provide sufficient processing power, it may lower
playback speed of high resolution recordings and
high-speed recordings. Also, DirectX 9.0 or later is
required for running the program and a VGA card
with 16 MB or more VRAM is recommended.

+ The video may not be displayed on the screen

correctly depending on the PC's display settings.
In such case, right-click on the desktop, go to
Display Properties — Settings tab, select

32-bit as Color Quality. Then, select Advanced,
go to Troubleshooting tab, and set Hardware
Acceleration as Max.. If the problem persists,
click Start — Run, type in dxdiag and press
Enter. In the DirectX diagnostics tool window,
confirm that the DirectX version is 9.0 or higher.
In the same window, go to Display tab and make
sure that DirectDraw Acceleration is set as On. If
running Microsoft® Windows® XP, test the settings
by pressing the DirectDraw test button. Check
the driver version of the VGA card. If it is not the
latest version, update it with the latest version of
the driver. If the problem persists after all of the
attempts above, switching the PC's VGA card is
recommended. VGA cards that use ATl chipsets
are recommended for IDIS Center .

If Exclude proprietary viewer option was
selected when saving a recording, the proprietary
viewer (IDIS player.exe) provided in IDIS Center
software installation folder (\Client\selfplayer)
needs to be run to play the saved video.

+ The minimum operating system requirement

for Fisheye Dewarping is Window Vista. Fisheye
Dewarping is supported in the 1x1 layout only.
You can control by clicking the right mouse
button on the screen.
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Save as AVI File - Codec, Bitrate, Quality: Set the appropriate value for
video compression.

- Encoding Based on Bitrate: Encodes video based

Saves video recording as AV file(.avi). on bitrate

- Encoding Based on Video Quality: Encodes video
based on video quality.

- Size: Set the file size for the compressed video, then
select aspect ratio.

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.

- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.

- Fit to Screen(Aspect ratio): Resizes video to camera
screen while maintaining original aspect ratio.

Up, down, left, and right parts of the video may be

cropped depending on size of camera screen. When
using Image Zoom, aspect ratio of camera screen
does not apply and Original Ratio is applied.

- Anti-Aliasing: Removes stair step effect (blocks) that
are caused when zooming a video to improve overall
quality of video output.

- Keyframe: Set the interval of key frames for video
compression.

- Max File Size: Set the maximum size of the file.

- Save Split File: If the file size of the saved recording
exceeds Max File Size, the video is saved into multiple
+ From, To: Enter the date and time of the recording you files while not exceeding the maximum file size.

wish to save as video.
If Save Split File is not enabled, output file will be

- First: Sets date and time of the first video as the start . . )
limited to the maximum file size.

point.

- Last: Sets date and time of the last video as the end « View Proceeding Frames: Shows the current frame
point. being saved in a popup screen while saving.

- *1 Minute, +3 Minutes, £10 Minutes, +30 Minutes, . Include Watermark: Saves the specified watermark
+1 Hour: Adds or subtracts the amount of time from with the video.

the time currently selected on the timetable.
- Self-Player, AVI: Select AVI.

. . . AVI File Playback
- Fisheye Dewarping: Saves the video as dewarped _

image displayed on the screen. This function is The AVI file can be played by using a video player.
only activated in a single camera with the activated )
. . . . If the codec for the compression method used to save
dewarping function. The video can be saved in ) A
the AVl is not installed on the PC, the codec must be

panoramic or VR mode. .
installed manually.

+ Include Audio Data: Only a single channel is
supported if the video was saved with audio.

- If the video is recorded at a size smaller than 1ips,
saving audio may not be successful.

98



Part 5 - Operation

Event Handling

The video of the camera in which event is detected
can be monitored live. If the event detection video is
recorded, the video recording can be played.

Emergency Event Panel will be displayed.

Events will be displayed on the list when Instant Event is
detected on registered devices.

If Callback Event is detected on registered devices,
Emergency Event Panel will be displayed automatically
or bring up manually.

To bring up Emergency Event Panel manually, Click View
-> Emergency Event Panel or Click Il button on Event
list.

Emergency Event list will be displayed when Emergency

Event is detected.

+ Auto Popup: Emergency Event Panel will be displayed
automatically when Emergency Event is detected on
client system.

- Event Count: Shows the count of displayed event.
« Last Event: Shows the information of latest Emergency
Event.

Callback events are only displayed if the callback

- feature is enabled on the device. Event list indication
options can be changed in Settings > Report. For
more details, refer to Report on page 43.
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Event Icons Indicated on the Event list

Mask Rule

Violations/Off

Queue
congestion
detection/Off

Motion
1 System Action
* Detection 4
- 3 Video blind * Restart
~
= Video loss [©) System shutdown
Malfunction
Object
S in recordin
= detection ‘@ function 9
Video-analytic
Disk full
detection L sk
TripZone H Disk almost full
Bad sect
Tampering ké diask sectoron
Text-in Disk setting
detection = change
Activate/ No error on
Deactivate
O/ alarmein 0) S.M.AART.
. diagnostics.
detection
High disk
) temperature
Alarm-in error/
@/ no error u shown on
S.M.AART.
diagnostics

External storage

Start/end panic

i ted
O/ [ | inserted/ 0 / G recording
removed
Device
Disconnection/
. Fan error / No fan
5‘5 / Q Device / error
Connection
Failure
System boot Face Detection
/ Exceed People / Exceed Time Limit
Limit On/Off On/Off
/ VA Loss / No VA / PIR Detection
Loss On/Off
/ ANPR Detection / Auto-tracking
On/Off Detection On/Off
/ Main Stream / Sub Stream
Recording/Error Recording/Error
E d
/ Alarm Box / Oxccceuepancy Limit/
Error/Off Off
Crowd Social Distancing
4 Detections/Off 4 Violations/Off
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Certain event icons may not be supported depending
on device's specifications and version.



Live Video

Monitoring live video from event detection cameras are

supported on up to 4 Live panels. If a Live tab doesn't
exist in the panel tabs, you can add them by selecting
New Tab in the System menu and clicking Live.

In the panel tabs, click the Live tab.

In the Live Event list, select an event you wish to

monitor. Then, drag & drop the selected event on the

Live screen using your mouse. The live video of the

camera in which selected event was detected will be

displayed on the screen.

Part 5 - Operation

Video Playback

Playback of recorded event videos is supported in the
Play panel. If a Play tab doesn't exist in the panel tabs,
you can add them by selecting New Tab in the System
menu and clicking Play.

In the panel tabs, click the Play tab.

In the Live Event list, select an event you wish to
monitor. Then, drag & drop the selected event on the
Play screen using your mouse. The recorded video of
the selected event will be displayed on the screen.
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System Status Monitoring

The system status of registered devices can be monitored

live.

System status monitoring is supported in the Status
panel. If a Status tab doesn't exist in the panel tabs, you
can add them by selecting New Tab in the System menu
and clicking Health.

Once Health tab is added, the health monitoring results
are automatically displayed.

. Summarized list: Summarizes status of all devices
added to the device group.

Total: Shows the total number of devices added to
all device groups.

Problem: Snows the number of malfunctioning
devices.

Unreachable: Snows the number of disconnected
devices.

Healthy: Shows the number of devices that are
operational without malfunctions.

- Detailed list: Shows the status of each device in detail
(The status may not be displayed depending on the
device).

Status: Shows status.

Healthy

No malfunctions have been
detected.
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Video loss, event detection,

Problem alarm-in device error, recording
error
Unreachable Device is not connected.

- Problem: Shows the cause of the malfunction.

- Group: Shows the device group in which the device
is registered to.

- Address: Displays the device’s IP address.

- MAC Address: Displays the device’s MAC address.
- Site: Shows name of the device.

- Version: Shows device's software version.

- Cameras: Shows status of the cameras used by the
device.

- Alarm In: Shows status of the alarm-in device used
by the device.

- Fan: Shows fan error status.

- Record: Shows recording status.

- Record Check: Shows recording check status.
- Record Period: Shows recording period.
Function buttons

- (Refresh): Displays the newest information of the
health monitoring panel.

- (Event Condition): Sets the conditions for events
to display. The data of the health monitoring which
belong to the selected condition is displayed.

- |8 (Save): Saves the data of the health monitoring
panel in .txt, .csv, .html and .pdf formats.

- [ (Full Screen): Shows the Status Panel in full
screen.



Device Status Monitoring

The device status of registered devices can be monitored
live. Device status monitoring is supported in the Device
Status Panel. If a Device Status tab doesn't exist in the
panel tabs, you can add them by selecting New Tab in
the System menu and clicking Status.

In the Site list, select a device you wish to monitor. Then,
drag & drop the selected device on the Device Status
Panel using your mouse. The status of the selected device
will be displayed.

- Status Indicator Window: Shows the status using
icons.

- Version: Shows system version.
- Camera: Shows camera number

- Event: Shows event detection status. Colored event
icon indicates that an event was detected. When the
cursor is placed over the icon, the type of the event
is shown in tooltips.

- Alarm Out: Shows Alarm-out status.

- System Check: Shows status of device and recording
function.

Part 5 - Operation

« Function buttons

- (Disconnect): Disconnects current connections in
the Device Status Panel.

- B8 (Panic Recording): Remotely starts or stops panic
recording of the device.

Only supported for DVRs with panic recording
support.

- Rec. From/Rec. To: Shows recording period.

- Status: Shows device's recording, playback, backup
and clip copy statuses.

- [ (Full Screen): Shows the Device Status Panel in
full screen.

Self-Diagnosis

Self-diagnosis is supported for overall diagnosis and
reporting of a recorder's system, network and camera
status. If a Self-Diagnosis tab doesn't exist in the panel
tabs, you can add them by selecting New Tab in the
System menu and clicking Self-Diagnosis.

In the Site list, select a device you wish to monitor. Then,
drag & drop the selected device on the Self-Diagnosis
Panel using your mouse. The self-diagnosis of the
selected device will be displayed.
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Log search

Searches the log of IDIS Center program and devices.
Log search is supported in the Report Panel. If a Report
tab doesn't exist in the panel tabs, you can add them
by selecting New Tab in the System menu and clicking
Report.

- Self-Diagnosis: Shows the overall status of a recorder
in a report format.

+ Reports: Shows the results of self-diagnosis with date
and summary.

+ Troubleshooting Reports: Creates and saves a self-
diagnosis report dumb file to send it to the partner site.

- (Request Troubleshooting Reports): Creates
troubleshooting reports.

- @ (Delete): Deletes the selected troubleshooting
report from the list.

- E (Save as File): Saves troubleshooting reports as
a dumb file. After saving is complete, click Register
Partner Portal and enter the partner site account if
connected to the external network, to report the
dump file to the partner site.

- (Refresh): Shows the newest list of the
troubleshooting reports.

« Function buttons

- (Disconnect): Disconnects current connections in

the Self-Diagnosis Panel. When a log list is displayed, you can right click on the

- Bl (Refresh): Reloads the self-diagnosis report. column data to bring up a menu, which can be used to
- H (Save): Saves the self-diagnosis report as an categorize the data to your preference.
HTML file (html).

- B (Print): Prints the self-diagnosis report.

- [E (Full Screen): Shows the Self-Diagnosis panel as a
full screen.
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- Log type: Select the type of log to search in the list.
- User Log: Shows IDIS Center Program's log.

- Health Log: Shows the system status log of
registered devices.

- Device System Log: Shows device's system log.

- Device Event Log: Shows device's event log. If
the device is a network camera or a network video
server, only the events that occurred while SD
(SDHC) Memory Card Recording feature is enabled
can be searched.

- Admin Service Log: Shows maintenance service
log. For more information, contact your IDIS Center
software retailer.

- Monitoring Service Log: Shows monitoring service
log. For more information, contact your IDIS Center
software retailer.

. (Search): Search log.

Report toolbar

The specific logs can be searched by using the toolbar at
the bottom of the panel.

« From, To: Set the date and time of the logs to search
for. Enter a specific date and time or select First or Last
options.

+ Click the 1 Hour, 6 Hour, Today, 3 Day, or 7 Day
V buttons to adjust the From and To by the amount
of time that corresponds to each button.

« Selecting the First or Last options will search
every log from the oldest to the most recent.

- [@ (Condition): Select the type of log to search for.

. (Search): Begin search according to the search
criteria.

- [ (Full Screen): Shows the Report Panel in full screen.

- B (Save): Saves the search results as as a text file(.txt)
ora CSV file (.csv).

System and service logs can be saved as password-
\/ protected HTML files (.html). Password must be
entered to view HTML files.

- & (Print): Print the search result.

« More: Shows next results.

Part 5 - Operation
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Browser

Web browser is available in the Browser panel, and panels can be added up to 8 in maximum.

Browser Screen

—o

o

Browser Panel Name

Each browser panel name is displayed. Panel names are maintained for every login and

different panel names can be saved for each user.

Browser Page

Displays a web page. Empty address displays the default page.

Browser Toolbar

Basic browser functions are provided.

©e | o 0| ©

Browser Device

Select System > IDIS Center Setup > Device and add browser device to the Browser under

Site. Drag and drop the device to the browser page to move to the address set in the device.
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Default Page Browser Setup

Configures settings of the current browser panel. Browser
settings are managed for each user, and the settings are
retained for relogin.

When a Browser tab is added without a start page,
the default page is displayed.

- Tab Name: Enter a browser tab name.

Enter a blank URL in the address bar and press Enter
to move to the default page. If you move to the
default page with a start page set up, a message
which says "Enter URL" is displayed.

Start Page: Sets the start page of the browser panel.
Entering a blank URL displays the default page. Click
onthe (Current Page) button to set the current page
URL as the start page.

- Enable Popup: Enables a popup in a browser page. A

Select Browser Setup from the default page to bring popup is blocked when this option is not selected.

up the browser setup screen to assign the start page. + Allow Custom URL Schemes: Allows custom URL
schemes to bring up a specific web page.

Browser Toolbar

. / (Previous/Next Page): Moves to the previous/
next page.

. (Refresh): Reloads the current page.
. (Stop): Stops loading a page.
. (Homepage): Moves to the set homepage.

. (URL address): Enter an
address.

. (Save as PDF): Saves the current page as a PDF file.

. (Browser Setup): Configures the current browser's
panel information settings.

. (Full Screen): Displays the browser panel in full
screen.
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MapVue Search

You can search and play recorded video of a specific object, and use a map to check the location of playback device.
The bookmark feature can build up a scenario to track the object's actions and movements. MapVue search is
supported on the MapVue Search panel. Select New Tab from the System menu and click MapVue Search to add a
tab.

MapVue Search Screen

(1) (6)

of v

(4]
(1] Map Monitors the status of registered devices on a map.
(2] Playback Screen Plays all of recorded data related to MapVue search.
O | Goto Searches video of specific date and time.
(4 Options Select map/playback options.
(5] History Displays history of camera registration and recorded time of the playback screen
O | Bookmark Saves map and playback video of selected time as bookmarks.

\/ You can adjust the size of each section by dragging the corner.
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MapVue Search Toolbar

. (Open MapVue Search File): Opens a MapVue
Search data file. The current MapVue Search status
of the data file is applied. Click the arrow button to

display the list of recently opened MapVue Search files.

. (Save MapVue Search File): Saves the current
MapVue Search file.

. (Save MapVue Search File As): Saves the current
MapVue Search file with a different name or location.

. (Save As Excel): Saves the bookmark data as an
Excel file.

. (Close MapVue Search File): Initializes all of the data.

- El (Full Screen): Displays the MapVue Search panel in
full screen.

Device Registration and Recorded
Video Playback

Drag&drop a device from the site tree to the map section
to register a map. For the playback screen, you can
register the camera devices from the map and devices
from the site tree by drag&drop. When the MapVue
Search panel is activated, double-click on a device of the
site tree to easily register the device.

Map

Monitors the status and location of the registered
devices, and tracks the movement of an object. It
supports all of features from Map Monitoring on page
60 and Map Control on page 75 except for Event
Action of Map Monitoring. Double-click on the device to
display the recorded video on the playback screen.

The background of the device blinks when the
bookmark or history is played.
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Device Context Menu

Use the context menu to check the device or playback
status.

- Play Recorded Data: Displays the recorded data of the
device on the playback screen.

+ Instant Viewer: Displays a popup with a real-time
monitoring video.

« Information: Displays the device status information.
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Device Tooltip

Brief device information is displayed in a tooltip when
you put a cursor on a device.

« Device Name: Displays the selected device name.

- Site: Displays the name of the highest device that
includes the selected device on the site tree.

+ Number: Displays the channel number.

+ Model: Displays the model type or name of the site
device.

« Address: Displays the address and port number of the
site device.

Playback Screen

Plays the recorded video from the MapVue Search. Use
a control toolbar to use Recorded Video Playback on
page 81 features. You can switch to 1x1 screen layout
by a double-click on the playback screen.

.

« Use the context menu to add history and bookmark.

The device cannot be simultaneously registered on
the Play panel and MapVue Search panel.
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ROI Connection

Connect the Region Of Interest (ROI) of the registered
camera video on the playback screen to use the features.

For fisheye cameras, the displayed screen becomes the
ROI when ePTZ is on by the dewarping function (Client-
Side Dewarping). For general cameras, the displayed
screen becomes the ROl when the dynamic zoom
function is activated.

When saving history/bookmark, ROl is saved and the
backed up ROl is displayed for the playback. Bookmark
snapshots and thumbnails of the dewarping video are
saved as ROl images. If the dewarping mode is select
mode or spot mode, the selected ROl pane is used as the
bookmark image.

The ROI connection is effective for fisheye camera
videos and high resolution videos such as UHD.



Goto and Options

Goto

You can search for the specific time of the recorded video

on the playback screen.

<Calendar Widget>

<Time Widget>

- Bl (Move Time): Displays the recorded video of date
and time selected on the playback screen.

. . (Move To Last): When the dynamic zoom function is
on, the displayed image becomes the ROI.

+ Load Adjacent Frame: Displays the most adjacent
frame if there is no available image for the selected
time.

+ Date/Time: Select date and time to search the image.
You can use mouse wheel, number keys and arrow
keys to enter the date/time. Click the  button or
right mouse click on the date to bring up the calendar
widget, and right mouse click on the time to bring up
the time widget.
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Options

Select MapVue Search playback and map options.

+ Autoplay on double-clicking the map device: Select
to register on the playback screen and automatically
play when you double-click the map device.

+ Autoplay always on running the history: Select to
play the video at the same time the recorded video is
registered on the playback screen.

+ Autoplay on running the bookmark: Select to
register the recorded image on the playback screen
and automatically play when you run the bookmark.

- Device focusing on running the bookmark: Select
for device focusing on the map when you run the
bookmark.

History

Registering camera devices on the playback screen or
moving to other recorded time are added to the History
section. You can track the past search history and register
to the bookmark.

History List

Time search from the Goto section and time table search
are added to the History list. Running thumbnail search
or event search results adds to the History list as well.

A history item is added to the end of the list and the scroll
automatically moves to the added item unless another
selected item is being played.
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The number of current and maximum history items is
displayed on the right top of the list. If the number of
items exceeds the maximum number (up to 1000), the
oldest item is automatically deleted.

Inaccessible devices or deactivated devices are colored
dark and cannot be played.

Context Menu

Mouse right click on the History item to bring up the
following context menu.

- Run: Displays the recorded data of the device from the
History list on the playback screen.

- Add Bookmark: Adds the history to the bookmark.

+ Add: Adds the current MapVue Search history under
the selected item on the list.

« Delete: Deletes the selected item.

- Give an asterisk: Gives an asterisk to the selected item.

- Remove all asterisks: Removes all asterisks from the
items with an asterisk.

« Delete items without an asterisk: Deletes all of the
items without an asterisk.

« Use Tooltip: Select to use a tooltip for the History list.

History List Tooltip

Hover a mouse cursor on a History item to bring up the
information in a tooltip.

« Device Name: Displays the selected device name.

- Site: Displays the name of the highest device that
includes the selected device on the site tree.

» Map: Displays the map device connected to the

selected device.
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- Recorded Time: Displays the recorded time of the
image of the selected device.

- Date Created: Displays the date and time when the
History item was added.

List ltem Control

+ Add History: Select Add History from the playback
screen context menu, or select Add from the History
context menu to add a history according to the current
playback status and time. Map device information is
also saved if the playback device is connected to the
registered map device. When the items are listed with
the Sort by asterisk filter, a history item is added with
an asterisk when a user manually adds one.

+ Delete History: Select X (Delete) button from the
History list or select Delete from the context menu.
The X (Delete) button is displayed when you put a
mouse cursor on a History item. Click the  button on
the top right of the list to delete all of History items.

+ Run History: Double-click on the History item or select
Run from the context menu to run a history. When
you run the history, the camera is registered and the
selected time data is displayed on the playback screen.
The history with map device information registers the
map device on the map section. Double-click on the
map device with the Autoplay on double-clicking
the map device option or select Play Recorded Data
from the Map context menu to add a history item with
automatic playback.

« Asterisk Option: An asterisk feature is for managing
priority of history items. Click the  button on the
left of each history item to enable/disable an asterisk.
Selectthe (Sort by asterisk) button on top of the
history list to filter items with an asterisk only (). The
History context menu suggests asterisk options: Give
an asterisk, Remove all asterisks and Delete items
without an asterisk.



Bookmark

You can add the current status of MapVue search or
history to the bookmark. Bookmark recorded video
and route of the specific object to form up a scenario.
Bookmarks can be saved as Excel files.

No Title

1 Test

<List Mode> <Thumbnail Mode>

. (Add Bookmark): Adds the current MapVue search
status to the bookmark.

. (Edit Bookmark): Edits the bookmark information.

. (Run Bookmark): Displays the selected bookmark's
map and recorded data on the screen.

. (Thumbnail List): Displays the bookmark list with
thumbnails.

Inaccessible devices or deactivated devices are colored
dark and cannot be played.

Context Menu

Mouse right click on the Bookmark item to bring up the
following context menu.

+ Run: Displays the selected bookmark's map and
recorded data on the screen.

» Add Bookmark: Adds the current MapVue search
status to the bookmark.

- Modify: Edits the bookmark information.
« Delete: Deletes a bookmark.

- Save Snapshot: Saves a thumbnail saved in the
bookmark as a file.

- Save as Excel: Saves the bookmark list information as
an Excel file.

« Use Tooltip: Select to use a tooltip for the Bookmark
list.
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Bookmark List Tooltip

Hover a mouse cursor on a Bookmark item to bring up
the information in a tooltip.

« Title: Displays the selected bookmark name.

+ Thumbnail Image: Displays a playback screen
snapshot of the time (+ 2 seconds) when the bookmark
was created.

- Device: Displays the device name of the selected
bookmark.

« Site: Displays the name of the highest device that
includes the selected device on the site tree.

« Map: Displays the registered map device included in
the bookmark.

+ Recorded Time: Displays the recorded time of the
video.

- Date Created: Displays the date and time when the
bookmark was created.

- Date Modified: Displays the latest date when the
bookmark information was modified.

« Comment: Displays a comment that describes the

bookmark.
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. Add Bookmark: Select the

Part 5 - Operation

List Item Control

(Add Bookmark) button
at the top of the bookmark list, or Add from the
bookmark list context menu, or Add Bookmark from
the playback screen context menu to add the current
map and playback status to the bookmark. Select

Add Bookmark from the History list context menu, or
drag&drop a history item to the Bookmark list to add
as a bookmark (up to 1000 bookmarks).

When adding a bookmark, the following window is
displayed. An item is created on the Bookmark list after
configuring the setting.

- Snapshot: Displays the selected image from the
thumbnail list. Thumbnails show images of recorded
time in the range of -2 sec, -1 sec, 0 sec, +1 sec, +2
sec.

- Title: Enter the bookmark title (up to 64 characters).

- Comment: Enter the bookmark description (up to
256 characters).

- Information: Displays the device, site and recorded
time of the bookmark.

Run Bookmark: Select the  (Run Bookmark) button,
or double-click on the bookmark item, or select Run
from the context menu to load the map and recorded
data of the bookmark. If the Autoplay on running
the bookmark option is enabled, the bookmark
automatically plays the recorded data. If the Device
focusing on running the bookmark option is enabled
and a map device is connected to the playback

device, the device focusing is automatically activated.
Drag&drop the bookmark item to the playback screen
to register the device and play the recorded data.

Edit Bookmark: Select a bookmark and click the

(Edit Bookmark) button at the top of the bookmark list,
or select Modify from the context menu to edit the
bookmark information.
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- Delete Bookmark: Select X (Delete) button from

the Bookmark list or select Delete from the context
menu. The X (Delete) button is displayed when you

put a mouse cursor on a bookmark item. The popup
window is displayed when you select Delete, and press
Shift and Delete to delete the item without the popup
window. Click the  button on the top right of the list
to delete all of bookmark items.

Arrange Bookmark List: Drag&drop the bookmark list
item within the Bookmark section to rearrange. Press
Ctrl and drag the item, and drop it on the Bookmark list
area to switch the position in the list. Click the name

at the top of the bookmark list to arrange the items in
ascending/descending order.

Save Bookmark as an Excel file: You can save the
bookmark list information as an Excel file. Select the
(Save As Excel) button on the MapVue Search toolbar,
or Save as Excel from the context menu.
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Map Editor On the Site panel, select the I/0 devices connected to
the device and subordinate map. Then, drag & drop

them to the desired position on the canvas.
By registering a map, camera videos, events, and status of

connected 1/O devices can be monitored on a map.
Configure the map.

Enter a name for the map and click OK to complete
Map Reglstratlon map registration.

On the Site panel, click on Map, then click on the 4

Select Setupin System menu and select the Device button at the bottom of the Site panel on the left. An

menu. Add Map Group window will appear on the screen.

On the Site panel, click on Map, then click on the
=+ button at the bottom of the Sites List panel on
the right. A Map Editor window will appear on the
screen.
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Map Settings
(3]
(4]
(1] (2]
(5]
. Shows a list of registered devices and maps. Registered devices and maps can be
O |site . .
searched by typing search query in the £, field.
® | canvas Create a map by inserting a background image and positioning desired I/0 device

icons and map links from the Site List.

(3] Settings Buttons

Configures the map.

+ Alignment: The I/O device icons or map links positioned on the canvas can be aligned to
user's preference.

- [ (Text box): Inserts a text-box for entering text.

. (Route sequence): Sets route sequence.

- ] (Map object name sync): Automatically syncs names of I/0 devices depending on the
devices' settings.

- ] (Insert background image): Inserts a desired background image to the canvas.

- |8 (Status color): Designates colors to indicate event detection and I/O device status on
the map.

. (Delete): Select 1/0 device icons or map links you wish to delete from the canvas and
click the Delete button to delete the selected I/0 device icons or map links from the
canvas.

(4] Properties

Sets the properties of map, the canvas of the map, and I/0 device icons or map
links positioned on the canvas.

® | EventAction

Set the event action for the I/O device icons positioned on the canvas. When an
event is detected on the map, the user is notified by the defined actions.
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Icon Alignment

After selecting more than one I/0 device icon or map
link, you can click the Align buttons to modify their
position on the canvas and size at once.

- BB/ (Positioning): Aligns one or more icons to the
horizontal / vertical center of the background image.

-
..*.

- E/Mm,E /6, A/ HE (Positioning): Aligns two
or more icons based on the icon that was selected last.

« [0 / B (Spacing): Adjusts the spacing between three
or more selected icons to be regular.

- [Hl / 1 / & (Resizing): Resizes the width / height /
size of two or more selected icons to be the same. Only
applies to same types of icons with different width and
height ratios.

Properties

The properties of canvas, 1/0 device icons or map links
on the canvas can be set. After selecting a canvas, an icon
or a map link, select each property, and manually enter
the desired value or select a desired value from the drop
down menu.

Map Attributes
Root Map
Canvas

Width 1920

Height 1080

[ ] 255; 255; 255

"Iginal kaio

Mot Lise

Color

Image Position
Image Width
Image Height

=1E=1Fs]
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« Map Attributes: Sets the map properties. When Root
Map is set as Use, a list of devices registered to the
map is displayed on the right-handside of the Map
Panel when monitoring a map.

Only applies to Map Panels.

- Canvas: Sets the properties of canvas or background
image inserted to the canvas.

- Width, Height, Color: Sets the width, height, and
color of the canvas.

- Image Position: Sets the position of background
image inserted to the canvas.

- Information: Shows the width and height of the
background image inserted to the canvas.

« Device: Sets the properties of selected I/O device icon.

- Name: Sets the name of the device icon. 17
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- lcon, Ratio: Sets the shape and ratio of the device
icon.

- X Coordinate/Y Coordinate, Width/Height: Sets
the position and size of the device icon. These values
can be adjusted by dragging the icon on the canvas
with your mouse.

- Associated Camera: Cameras can be connected to a
device. When a camera is connected, the video from
the connected camera can be watched when the
event is detected. Map link can be set for an alarm-in
device.

Only supports Alarm-in or Audio Input devices.

- Halo effect: Sets background color of an icon for
locating the icon easier on the map.

- Camera View: Configure viewing angle, pan, and
distance.

Only supports camera devices.

- Information: Shows the device information.
Map link: Sets the properties of the selected map link.

- Name: Sets the name of the map link. The name
entered is displayed on the map link.

- X Coordinate/Y Coordinate, Width/Height: Sets
the position and size of the map link. These values
can be adjusted by dragging the map link on the
canvas with your mouse.

- Text Color, Background Color: Sets the font color
and background color of the map link.

- Opacity: Sets the opacity of the background color of
the map link.

- Align Text: Aligns the text of the map link.

- Information: Shows name of the map.

Text Box: Sets the properties of the selected text box.
- Text: Sets text. The set text is displayed on the map.
- Font, Font Size: Sets font and font size.

- Text Color, Background Color: Sets the font color of
the text and background color of the text box.

- Align Text: Aligns text.
- Bold, Italic, Underline, Strikethrough: Applies
bold, italics, underline or strike-out to the text.

- X Coordinate/Y Coordinate, Width/Height: Sets
the position and size of the text box. These values
can be adjusted by dragging the text box on the
canvas with your mouse.
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Path Sequence

By setting a sequence route, videos from multiple
cameras can be monitored sequentially on the same
camera screen when using Map monitoring. A path
sequence must be registered to each camera on the
canvas to use.

Click the B4 (Path Sequence) button.

On the canvas, click on the camera icons in the order
you wish to monitor them.

Complete path selection by right-clicking your
mouse. Once a path is set, select the path and set the
properties.

Name: Sets the name of the path.
Color/Opacity/Width: Set the color/opacity/width
of the path displayed on the map.

Shape: Set the shape of the icon for identifying the
camera when a video from a path sequence camera
is displayed while monitoring a map.

Background Color/Opacity/Margin: Set the color/
opacity/margin of the icon displayed when a video
from a path sequence camera is displayed while
monitoring a map.

Reverse: Changes direction of the path.
Associated Device: Shows a list of cameras selected
for path sequence. When monitoring a map, the
path sequence will show the videos from each
camera in the defined order for the Dwell Time
value.

By selecting a camera from the list and clicking
Remove, the camera can be removed from the path
sequence.



Event Action

Sets the event actions to be performed when events are
detected in the I/O devices positioned on the canvas.
Select an icon, item, and select the desired value from the
drop down menu.

« Click: You can configure event actions so that clicking
the device icon on the map brings up Instant Viewer
window. If the device is the alarm-out device, you
can configure it so that clicking the icon activates
or deactivates the alarm and delays activation/
deactivation during the specified time.

« Motion Detection, Object Detection, Video Loss,
Video Blind, Alarm In, etc: Set or cancel the actions to
be performed when each event is detected.

- Live Popup: Pops up the video of the camera (a
connected camera if the device is not a camera).

- Event Spot: Shows the video of the camera (a
connected camera if the device is not a camera) on
the Event Spot Screen.

- Event Sound: Plays audio if audio file(.wav) is
selected.

.

« To change settings to ignore event actions, right-
click on the Map I/0 Device and select Ignore Event
Action.

If the map is configured to ignore event actions of
1/0 devices, the event actions will not be performed
regardless of the settings in this window.

Part 5 - Operation

FEN Service Use Agreement

According to the privacy protection policy of GDPR
(General Data Protection Regulation) and CCPA (California
Consumer Privacy Act), you should agree with the IDIS
privacy policy (https://www.idisglobal.com/index/
privacy) in order to use the FEN service.

Click About menu and select Privacy Policy and
configure FEN service use agreement setting for each
device.

FEN Service Use Agreement

Select to agree with the IDIS privacy policy. Each of
FEN service registered device can have an agreement
respectively, and these devices can use the FEN service.

Click About menu and select Privacy Policy.

Press Learn More from the window below.

Read the FEN service terms and click the Accept and
Use button. Click the link below the terms to check
the IDIS privacy policy.
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Select a device to register for the FEN service use
agreement and click Accept.

Successfully registered devices are displayed
Completed under Status. Failed devices are
displayed with descriptions under Status and
Reason.

When the logged in device account is not an
administrator, Account verification required is
displayed under Status with a below popup message.
Enter the administrator user information and click OK
to register the device under the agreement.

The message pops up when the agreement is
complete. Click OK for additional agreement or click
Exit to close the privacy policy window.

Pressing the . (Refresh) button after clicking OK,or
opening the privacy policy again after clicking Exit
hides completed devices from the list.

FEN Service Decline

Select devices to decline using the FEN service. Each
of FEN service registered device can be declined
respectively.

Click About menu and select Privacy Policy.

Press Learn More from the window below.

Read the FEN service terms and click the Decline
button. Click the link below the terms to check the
IDIS privacy policy.
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Select a device to delete from the FEN service and
click Do not use. Clicking Go back returns to the FEN
service use agreement page.

Enter the administrator user information for each
device and click OK to delete from the FEN service.
If you do not know the administrator account, click
Skip to move on to the next device.

The message pops up after the verification is
complete. Click OK for additional deletion or click
Exit to close the privacy policy window.

Pressing the [Bll (Refresh) button after clicking OK,or
opening the privacy policy again after clicking Exit
hides deleted devices from the list.
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A-Cut Monitoring Panel

Screen Layout

You can view the A-cut images received from camera devices registered under the Monitoring tab.

Popup Configuration

The A-cut images transmitted from camera devices registered in the Monitoring tab are available for viewing.

o
| (2 | oL

0

Popup Settings and Function Collection Area

Filtering Settings Area

A-cut Item Count Widget and Delete All Button

© © o0

Update Lock Status Bar
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A-cut Composition

Part 5 - Operation

@ Select whether to set or unset as a favorite.

@ Display the properties of the A-cut item.

@ Play the selected A-cut section using instant playback.

@ Register the selected camera to the Play tab and move to the
start time of the A-cut section.

® Display the recording point, camera name, and recording time of
the A-cut item.

® Display the color.

A-cut Context Menu

Delete: Deletes the selected A-cut items

Mark as favorite: Marks or unmarks the selected A-cut items as
favorites.

Reset all favorites: Unmarks all A-cut items that have been marked
as favorites.

Delete non-favorites: Deletes all A-cut items that are not marked
as favorites.

Attributes Placement: Sets the display format for attributes. (Auto
/ Horizontal / Vertical)

A-cut Tooltip

@ Displays the object type of the A-cut item.

@ Displays the attributes of the A-cut item.

@ Displays the recording point name, camera name, and recording time of

the A-cut item.
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Filtering

® Specifies the target range for the text filter.
@ Enter the text to filter.
@ Resets the object type filter.

@ Displays the filter attribute selection widget based on object type. Right-click to directly apply the most recently used
filter settings.

® Displays only items marked as favorites. This option can be used in combination with other filter settings.

® Allows for the configuration of filter attributes based on the selected object type.

Update Lock

When an A-cut item is clicked, the update lock is activated. While the update lock is active, the display of newly added A-cut
items is delayed. Upon deactivating the update lock, all delayed A-cut items will be displayed at once. The update lock can
be released by either clicking the selected A-cut item or by clicking the update lock bar at the bottom of the popup. The
update lock will automatically be released once the duration set in the popup settings has elapsed.
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Feature Descriptions

@ Displays a tooltip when hovering over an A-cut item.

0000 @ Omits the display of the point name, camera name, and recording time.
@ Changes the window's position and size according to the location set in the IDIS Center
settings - [Screen Split] - [Side Panel Position].
@ Displays the popup settings widget.
Settings
Popup Settings

« Title: Sets the title of the popup.

+ Auto Popup: Automatically opens the popup window when an
A-cut is received.

+ Always On Top: Keeps the A-cut live popup window displayed at
the front of the screen.

- Time to Keep A-cut: Configures the duration for which the A-cut
item remains displayed. Once the set duration expires, the A-cut
will be deleted.

- Update Lock Duration: Sets the duration for which the update
lock is maintained. Once the specified time has passed, the
update lock will be released.
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Site Registration and Search

Registration

After selecting a device from the site list, drag it to the central panel or the left search settings panel. Depending on
the site's registration status, a border will be displayed on the central panel as shown in the image below.

Lo |
L ©° ]

el
© Panel Border Indicators

Cyan | Site is available for connection. Red Site does not support Al search functionality.
Attempting to connect to a site that is already Site registration is unavailable due to ongoing

Gray . Yellow
registered. search or other reasons.
Attempting to connect to a site different from

Orange . . X Zoom Out.

the one previously registered.

O El(Unregister Site): Unregisters the currently registered site.

© Search Device: Filters devices based on the input string. Allows you to choose whether to search for individual
devices.

O search Range: Set the search range using the preset mode, which allows you to select a specific period starting
from a particular point, or the custom mode, where the user manually selects the search interval. The currently
selected search range is displayed at the bottom.
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Last 1h: Searches data from the past 1 hour based on the current time.

Last 2h: Searches data from the past 2 hours based on the current time.

Last 4h: Searches data from the past 4 hours based on the current time.

X Custom: Allows the user to define the search range manually. The range can
be selected by day or week using a calendar, or by entering the start and end

time directly.

O Search Settings

@ Select the object type to search for.

o ® Choose whether to perform an attribute-based
D search or interval-based search.

® Specify the search interval and minimum accuracy

0[ ] 6 threshold.
]| J

@ Deselect all selected attribute settings.

colors, you can choose between Normal Mode and
Combination Mode. In Combination Mode, only two
colors can be selected.

0 T ® Select the attributes to search for. When selecting

Search Results

Results

0 o o
J C X C—
5

@ Activated during search or while saving to an Excel file.

@ Displays the total number of search results.

@ Delete button: Activated upon completion of the search. Click to delete the search data.4 Panel Border Indicators
O Sorts search results in the selected order.

@ Displays the progress of the ongoing search.
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@ Saves the image and data of the selected A-cut
item as a PDF file.

@ Plays back the selected A-cut section in quick
playback mode.

® Registers the selected camera to the Playback
tab and moves to the start time of the A-cut section.

Search Results Tooltip

@ Indicates whether the result is from an attribute search, and if so, displays the object type.
@ Displays the data associated with the item.
@ Displays the camera name and the recorded time.

Search Result Display- Icon Guide

O 0 0 @ Toggles the default display of camera and recording time information.

@ Adjusts the size of thumbnail images.
@ Toggles the use of tooltips.
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Saving Options

Save as PDF

« Title: Specifies the title of the PDF report.

« Comment: Adds a comment to be included in the PDF report.

+ Footer: Adds a footer to be included in the PDF report.

+ Auto Close After Save: Selects whether the popup should close automatically after saving the PDF report.

+ Use Password: Enables password protection and allows you to set a password for the PDF report.
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Save as Excel File

L Je

@ Specifies the title of the Excel file.
@ Include Playback Shortcut: Adds playback shortcut links to the Excel file. These links are only accessible from the PC
on which the file was saved.

@ Selects the items to include in the Excel file. A maximum of 1,000 items can be selected.

O Displays a preview of the selected items. Clicking a preview item will navigate to the corresponding result in the
search list. Click the X button next to the selection count widget to deselect all items.

@ Executes the save operation for the Excel file.
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Control Using Network keyboards

IDIS Center program can be controlled using network
keyboards which needs to be purchased separately.

Only network keyboards of a certain model are
supported.

Registration
Register the network keyboard to IDIS Center program.

Select Settings in System menu and select the
Device menu.

Press the [—| (Network Keyboard Setup) button

and Network Keyboard Scan window will appear.
Registering a network keyboard is identical to
registering devices. For more details, refer to Device

Registration on page 12.

O
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IDIS Center system can be registered on the network
keyboard. For more details, refer to the network
keyboard user manual.

ID (IDIS Center System ID): It is automatically
assigned during IDIS Center System registration,
and can be changed.

- The ID is used to identify the system from other
\/ IDIS Center Systems. Therefore, a unique ID must
be set.

Name: Set a name for the IDIS Center System for
user convenience.

IP Address: Enter the IDIS Center System's IP
address. Do not select Use FEN.

Control Port: Enter the Control Port set in IDIS
Center System. Control Port settings can be checked
in System > Settings > Network > Network
Keyboard.

User ID, Password: Enter the User ID and Password
used to login to IDIS Center System.

In System menu, select IDIS Center Settings, and
then select Setup Network.
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Select Use Network Keyboard option to enable
network keyboards on IDIS Center System.

Connect

On the network keyboard, enter the IDIS Center
System ID.

Press DEV button to connect the network keyboard
to the IDIS Center System. If the connection is
established, a unique ID will be displayed on each
camera screen and panel Tab as shown below.

O
O

You can terminate connection by pressing the SHIFT
button and DEV button simultaneously.




Run

Live Video

On the network keyboard, enter Live panel Tab ID.

Press the DEV button.

Enter Camera Screen ID.

Press the PANE button.

In the Site list, select a site you wish to connect to
using the mouse connected network keyboard. Then,
drag & drop the selected site on the live screen using
your mouse. The live video of the selected site will be
displayed on the screen.

Part 5 - Operation

Pressing the [&] (Menu) button will bring up Live
Menu.

Navigate to the desired menu using the arrow
buttons on the network keyboard and press Enter
to select or deselect the menu. To leave the
current menu, press the (Menu) button and
deselect the menu.

Video Playback

On the network keyboard, enter Play Tab ID.
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Press the DEV button.

Enter Camera Screen ID.

Press the PANE button.

In the Site list, select a site you wish to connect to using the mouse connected network keyboard. Then, drag
& drop the selected site on the Play screen using your mouse. The recorded video of the selected site will be
displayed on the screen.

Pressing the 2] (Menu) button will bring up Play Menu.

Image Zoom r
Image Processing +
Motion/Object Search

Aspect Ratio r
Save Still Image...

Stream Information

Remave 4

Navigate to the desired menu using the arrow buttons on the network keyboard and press Enter [1] to select or
deselect the menu. To leave the current menu, press the (Menu) button and deselect the menu.
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Network Keyboard Buttons

Followings are the network keyboard buttons used to control the IDIS Center System.

For more details on PTZ control-related buttons, refer to the network keyboard user manual.

Command Buttons

Button

Description

Action

@

Numbers (1-9)

D - , [PANE], : Selects the monitor, camera screen, panel tab and
IDIS Center system to control.

@ Number (0) Not used as a command button.
Shift - Button: Runs the second function if the button has two functions.
@ Esc : Cancels a command while it is running.
Connect IDIS Center System ID — : Controls IDIS Center System.
Disconnect & : Disconnects from IDIS Center System.
Panel Tab TabID - : Selects corresponding panel.

Camera Screen

Camera ScreenID — : Selects corresponding camera screen.

Monitor

Monitor ID - : Selects corresponding monitor.

O® ®

(=) : Disconnects from the currently selected camera or device.

I
iy

Function (1-8)

+ F1:Shows monitor ID if two or more monitors are used.
« F7 (sHFT & F3): Shows or hides System menu — Settings window.
+ F8 (BHiFT] & F4): Shows or hides IDIS Center program's software version.
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IDIS Center System Control Buttons

Certain functions may not be supported depending on type and version of the connected device.

Button Description Action
Panic Recording . . .
on Camera ScreenID - : Begins panic recording of the camera screen.
Panic Recording . .
Off Camera ScreenID - & : Stops panic recording of the camera screen.
« Camera Screen|D - : Activates No.1 alarm output of the device connected
Alarm Output On to the current camera screen.
- Alarm Output Device Number - : Activates the selected alarm output.
« Camera Screen|D - & : Deactivates No.1 alarm output of the device
connected to the current camera screen.
Alarm Output Off . )
+ Alarm Output Device Number - & : Deactivates the selected alarm
output.
. : Changes screen layout. Select a layout by using the arrow keys and Enter
button.
Layout ) ) ) )
. & : Switches to 1x1 layout. Returns to previous layout if button is
pressed again.
Group : Switches to next screen group.
Freeze-frame : Freezes Live screen.
& : ifi i f the Li ified b d
Zoom : Magnifies certain area of the Live screen. Magnified area can be move
by using the arrow keys and Enter button.
Full Screen PanelTabID - : Shows the corresponding panel Tab in full screen.
. : Shows the Play Panel and can search or play recorded videos on the device
Search/Monitor connected to the camera screen selected on the Live Panel.
. & : Go back to previous Live Panel.
Rewind [««] : Rewinds video recording.
Rewind by frame & [««d] : Rewinds video recording by one frame at a time.
>/ Play/Pause : Plays video recording. Pressing the button again while playing pauses the
video.
Fast Forward [»] : Fast forwards video recording.
[»>] Fast Forward b
frame y & [»»] : Fast forwards video recording by one frame at a time.
Menu Shows the screen menu for the selected camera screen.
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« Selects the screen menu item of the selected camera screen.

Enter .
+ Changes zoom ratio in Zoom Mode.

- Navigates to screen menu item of the selected camera screen.
« Moves magnified area in Zoom Mode.
Arrow Keys + Only operates in Play Mode.

- Plays video by one frame at a time when the video is paused in Play Mode. Plays
or rewinds video by rotating the jog dial clockwise or counter clockwise.

Jod Dial + Zoom in/out the image by turning the jog dial.
og Dia
E « Changes playback speed when playing video recordings of a device.

@)

C

Shuttl R g ! /OUt the I age epeatEdW by tu n|ng the Shuttle |||Ig
e Rin
995 playbac :Speed wher pla)” 9 Vldeo [S]¢ Ordlngs Ofa deVlCe.
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Hotkey

Select the next pane of the selected

PgUp camera pane
F3 Run the screen magnifier
System Menu —
Ctl+Q+ Selected camera pane video image
drag designated area pixel counter
ROI-Drag .
display
System Ctrl + Alt + E: | Toggle Panic Event Manager panel
(IDIS Center) | popup
Hotkey Operation Ctrl + Alt +E:
(15S) Toggle Event Manager panel popup
Save screen capture image file,
Ctrl+ E te log fil if other | i
' j;(eciliezg & save [T otherlog save s Alt + F6 Select the tab on the right side of the
il tab docked in the main frame
Execute the print output function in
Ctrl + Alt + P | tabs that support screen capture image Alt + Shift | Select the tab on the left side of the tab
output and other print output +F6 docked in the main frame
Cirl + Alt + L Manu.al execution of Client S/W lock
function
Monitoring
| + Shif —
cur :PS it Run the Preference Device page
Hotkey Operation
T Toggle two-way audio
Screen
Shift + Home Toggle full screen including toolbar of
selected tab
Hotkey Operation
Screen division selection/creation
Ctrl + Enter | Toggle selected tab full screen Home dialog box pop up
Ctrl + Alt + | Toggle full screen with selected tab M h . fth
Enter toolbar Pause(Break) ove the previous group of the
screen format
Screen division selection/creation
Ctrl +F .
dialog box pop up F9 Toggle live zoom pop-up
Ctrl + PgDn Go to the previous group of the screen
format
Go to the next group of the screen @
Ctrl + PgUp
format
Hotkey Operation
Shift + Enter :’oggle selected camera pane 1x1
ormat Toggle play/pause playback
Ctrl + Space sessions for selected camera

PgDn

Select the previous pane of the
selected camera pane
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pane.

Ctrl + Shift + Space

Toggle batch play/pause of
selected playback sessions.
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(Step playback
or previous/next
button) Scroll the

mouse wheel

Jump to the specified time

(Jog shuttle)
Scroll the mouse
wheel

Shuttle step control

(Jog shuttle) Right-
click on the mouse

Shuttle lock

(Jog shuttle) Click
the mouse wheel

Shuttle reset (pause, unlock)

Ctrl + L Increase playback speed
Ctrl +J Decrease playback speed
Ctrl + K Ele;s;tt) é::)cli)yback speed (stop
Ctrl + P Normal speed playback
Ctrl+H Fast forward play
Ctrl+ G Fast Backward play
Ctrl+T Jump to time
Home Jump to the start
End Jump to the most recent point
F Jump to the next frame (Forward
Frame)
D Jump to the previous frame

(Backward Frame)

button.
Monitoring
Hotkey Operation
L Toggle two-way audio
Tab Display OSD with camera pane

video stream information

Ctrl + Right Arrow

1 sec. forward

(Live popup) F4

Cancel the Ignore Live Popup
function

Ctrl + Left Arrow

1 sec. backward

Shift + Right Arrow

1 min. forward

Screen

Shift + Left Arrow

1 min. backward

Hotkey

Operation

Alt + Right Arrow

10 min. forward

After dragging pane
(A), drop it onto
pane (B).

Change the position of the pane /

Swap the devices of both panes
(A and B) if both devices are
registered.

Alt + Left Arrow

10 min. backward

(Play or stop button)
Scroll the mouse
wheel

Jogging frame by frame

C + After dragging
pane (A), drop it
onto pane (B).

Clone the device registered in A
toB
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After dragging Clone the device registered in A to Device
pane (A), . . .
drop | B/ Device registration and Goto
rop it onto pane ) )
(B) on a different (A: Instant playback, B: playback .
screen. screen) Hotkey Operation
. Register a NumericlD device to the
NumericlD, .
| selected camera pane (root device,
ns
camera supported)
Sequence NumericID, L | Register a NumericlD layout to the
+1Ins selected screen
Unregister a device registered to the
Hotkey Operation Del
selected camera pane
hift + P h I
Shift +PgDn | Gotothe next layout Unregister the camera pane device
Ctrl + Del iated with th iousl istered
Shift+PgUp | Go to previous layout rl + De associated wi e previously registere
root device
Ctrl + Shift + Shift + Unregister a device registered to the
Go to the next camera sequence
PgDn Drag&Drop | selected camera pane
Ctrl + Shift + . Shift+ A+ | Bulk disconnect the devices registered on
Go to the previous camera sequence
PgUp Drag&Drop | the screen
Ctrl + Alt +
A + drop the .
. Register the screen format auto extender
device to the
Hover Toolbar camera pane
Drop to the | Force a live popup when dragging and
: live popup | dropping a device with a live popup
G S C b panel under the site tree
(Hover Focusing on the device location when
toolbar) Scroll scroll left and righ Drop to the . . )
the mouse croll left and right map pane dragging and dropping a device on the
wheel map page pane
Message Box Smart UX

Hotkey Operation Instant Playback
Copy the string from the message box to
the clipboard and then press Ctrl +V to

Ctrl+C P P Hotkey

paste the content into a text editor such as
Notepad.

Operation
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Toggle the instant playback to
previously run time interval
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Toggle the instant playback for 1

Shift +1 . B Add bookmark
minute
Refresh based on the current
Space Toggle play/stop R time/ Update recording time
range
Increase playback speed / Step-
L by-%tep control / Continuous run Shift + PgUp GfO :\0 the previous <time interval>
dunng keystroke of the recordlng time range
Decrease playback speed / Step- . Go to the next <time interval> of
J by-step control / Continuous run Shift + PgDn ina ti
the recording time range
during keystroke
(Caption time bar)
K Reset the playback speed Right-click on the | Toggle thumbnail mode
mouse
H Fast forward play / Step-by-step
control Scroll the mouse
wheel on the play | Jogging frame by frame
G Fast Backward play / Step-by-step button
control
P Normal speed playback (On the previous/
next button) Scroll | Move by 1 sec
Home Jump to the start the mouse wheel
; (On the previous/
End Jump to the most recent point P . Move by 1 min / Move by 5 sec if the
next button) Shift O o ]
recording time section is 3 minutes
. Jump to the next frame (Forward + Scroll the mouse or less
Frame) wheel
D Jump to the previous frame (Caption time bar)

(Backward Frame)

Ctrl + Right Arrow

1 sec. forward / Continuous run
during keystroke

Scroll the mouse
wheel

Move by 1 sec

Ctrl + Left Arrow

1 sec. backward / Continuous run
during keystroke

(Caption time bar)
Shift + scroll the

mouse wheel

Move by 1 min / Move by 5 sec if the
recording time section is 3 minutes
or less

Quick PTZ

Hotkey

Operation

Shift + Right 1 min. forward / Continuous run
Arrow during keystroke
Shift + Left Arrow 1 m.ln. backward / Continuous run
during keystroke
Tab Toggle the widget display
Shift + Tab Toggle the widget display mode

change (vertical / horizontal)

Ctrl + Drag left
button of the

mouse

Pan/Tilt control based pointer offset
speed
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Ctrl + Drag right
button of the
mouse (up/down)

Zoom In / Out control based pointer
offset speed

Close aperture

Ctrl + Scroll the

mouse wheel

Zoom In/ Out control

Ctrl + Shift + Click
the mouse wheel

Maximum zoom out

Ctrl + Shift + Drag
left button of the
mouse

Move Pan/Tilt so that the designated
position in the video is in the center

S PTZ control speed setting
Quick Dewarping
Hotkey Operation

Ctrl + Alt + Drag
the left mouse
button area

Move Pan/Tilt/Zoom to the
designated area in the video

(In the original
video) Ctrl + Drag
the left mouse
button area

Dewarp to the designated area in
the video

Ctrl + Alt + Click
the mouse wheel

Toggle area zoom history popup

Esc

Disable control mode if running in
PTZ control mode

Ctrl + Drag left
button of the

mouse

Move Pan /Tilt to the designated
area in the video

Direction keys on
the keyboard

Control PTZ 8 directions

Ctrl + Drag right
button of the
mouse (up/down)

Fine control of zooming in/out

Number pad 1~4,

Control PTZ 8 directions

6~9

Number pad 5 | PTZ preset popup

+ Zoom In

z Zoom In

- Zoom Out

X Zoom Out

/ Focus far

* Focus near
Number pad 0 | Open aperture
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Ctrl + Scroll the

mouse wheel

Zoom In/Out control

Ctrl + Click the

mouse wheel

Dewarping rset

Esc

Disable control mode if running in
ePTZ control mode

Quick Dynamic Zoom

Hotkey

Operation

(In the original video)
Ctrl + Drag the left
mouse button area

Zoom in to the designated area in
the video

Ctrl + Drag left

button of the mouse

Move the zoom area

Ctrl + Scroll the

mouse wheel

Zoom In / Out control




Ctrl + Click the mouse

Zoom reset
wheel
£ Disable zoom mode if running in
sC
dynamic zoom mode
Quick Save
Hotkey Operation
Automatically save the still image
with the path and file name set
Ctrl +5S

in the Settings -> Save -> Still
Image

Ctrl + Shift + S

Save as a stillimage

Ctrl+C

Save to clipboard

Part 5 - Operation
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Troubleshooting

Problem

Solution

Unable to monitor live video.

» Make sure that the device has been added to the device group.

« Make sure you have Live monitoring authorization.

| keep losing connection while
monitoring Live video and
program continues to attempt
to reconnect.

Check the device status and the network connection between the device and the
IDIS Center System.

| cannot see Live videos.

« Check device's connection to the camera.

« System or network overload may cause delays in the Live videos.

Event functions are not working.

Make sure that Device Real-Time Monitoring option is selected in Edit Device
menu. If the option is not selected, event-related features are only supported in
the device currently being monitored.

I cannot run IDIS Center
program because | forgot my
User ID and password.

Remove and re-install IDIS Center program. However, all data stored on the
system will be deleted upon uninstallation. Deleted data cannot be recovered.
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Mobile Player

Preference

System

Configure the system language, date and time.

Click on System menu > Preference > System.

- Language: Select the language to use when running
the program. The changed setting will take effect the
next time the program is launched.

- Disable display scaling on high DPI settings:
Uncheck to change the size of the client program
according to the DPI scale.

« Use GDI DPI Scaling: Makes text more visible on high
DPI displays. This function is activated only when
the operating system supports Use GDI DPI Scaling
and "Disable display scaling on high DPI settings
function is disabled.

- Use hardware acceleration when available: Use
this function in an environment that meets certain
conditions.

- Disable display power management on file open:
Display power management option includes Turn off
the display and Put the computer to sleep.

« Autoplay on File Open: Playback will start
automatically when a file is opened.

+ CPU Usage Popup: Shows a warning if the Mobile
Player system's CPU usage exceeds a set value and
notifies the user.

Part 6 - Appendix

« Number of Processors to use: Set up the number of
processors to use during the Mobile Player program
running. It allows you to limit the CPU usage for the
Mobile Player program running.

- Date/Time: Set the display format for current date and
time.

Screen Format

Configure the camera screen and layout-related settings.

Click on System menu > Preference > Screen Format.

+ Change the screen format based on the selected
camera: If enabled, the camera selected in the current
screen is positioned at the first camera screen when
the layout is changed.

Screen Display

Sets OSD(On Screen Display) display method on the
camera screen and enables / disables OSD.

Click on System menu > Preference > Screen Display.
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+ Position: Used to adjust the OSD's position, text size,
and margin.

« Text-In: Used to change the color and size of the text-
in.

+ Control ToolBar: Adjusts the opacity of control toolbar
on camera screen using the Opacity slider.

« Opacity: Adjusts the opacity of OSD using a slider.

. Selected Pane No Border: Hides the border of the
selected pane.

il
2009-06-04 17:53:00
Camera title, Status icon, Date/Time

- Selected Pane Title Bar Only: Displays the title bar of
the selected pane.

« Playback: Configures OSD information displayed on
the screen.
- Camera Title: Displays the camera name set in
Mobile Player program.
- Title bar: Separates the title display area at the top
of the camera screen.

- Site Name: Displays the name of the device. Displays
only if camera name and device name are different.

- Status Icon: Displays status OSD.

Control ToolBar

Zoom|n - Use Main Hover ToolBar: Sets whether the hover
toolbar is displayed in the camera pane. When
Color Control functions are executed via the context menu, the
hover toolbar is displayed regardless of this setting.
Image Effect - Popup on the Hover Zone: Toggles on/off the
Listen toolbar by a mouse cursor position in the hover

zone.

- Recorded Title: Displays the name of the camera

configured during video recording.

- Date, Time: Displays current date and time of Mobile Video Enhancement

Player.

Configure the video-related settings.
- VA Overlay: Displays video analysis data over the J J

monitoring video. Click on System menu > Preference > Video
- ePTZ: Displays the guide GUI (Graphic User Enhancement.

Interface) when you control PTZ in the fisheye

camera.

- Text-In, Text-In Dwell Time: If a text-in event occurs
on a device, text-in information is displayed on
the screen. (Only supports 1x1 layout.) The Text-In
information will be removed after the Text-In Dwell
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« Aspect Ratio: Sets the aspect ratio of video output.

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.

- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.

- Fit to Screen(Smart): Resizes video according to the
extra spaces, to the Fit to Screen or Actual Size.

- Fit to Screen(Aspect ratio): Resizes video to camera
screen while maintaining original aspect ratio.

Left and right part of the video may be cropped

- depending on size of camera screen. When using
Zoom, Hotspot, Event Spot, Show Motion Block
features, Original Ratio is applied instead of camera
screen aspect ratios.

- Actual size (1x): Displays the video in actual size.

- Drawing Mode: Choose the drawing mode for video
display on the screen. The overall color and display
performance may vary depending on drawing mode
settings.

« Maximum Frame Size: Select the maximum frame size
to display on screen.

+ Frame Skipping: Select the frame skipping to enhance
video performance if the video exceeds the decoding
specification.

- Level 1 - Based on system specifications: Apply
frame skipping in decoder configurations that
exceed video decoding specifications.

- Level 2 - Include when the pane size is smaller
than the video resolution: Apply frame skipping if
the size of the target camera pane is smaller than the
size specified by the original video resolution.

- Level 3 - Turn off loop filter: Applies codec's loop
filter off when skipping frames.
+ Low Latency Mode: Minimizes frames to be decoded
in parallel to reduce DPB (Decoded Picture Buffer).

Part 6 - Appendix

This feature requires high specification as it reduces
buffering, parallel processing and post processing.

Deinterlacing: If the video is encoded in interlaced
mode, this option removes horizontal stripes or noise
that may occur during movement to improve video
output quality. Select the desired de-interlacing filter.

Important Video Performance: Puts speed over
quality of video output when displaying videos on the
screen.

Anti-Aliasing: Removes stair step (blocks) artifacts that
are caused when zooming a video to improve overall
quality of video output.

High-Quality Downscaling/Upscaling: Maintains the
quality of video output when downscaling/upscaling
the video.

Trim The Black(noise) Edges: Removes black borders
(noise) around videos.

Monitor Vertical Sync: Improves tearing artifacts
caused when the monitor's refresh rate is low.

- Only supports 1x1 layout. CPU usage may increase if
this option is enabled.
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Video Analysis

Configure video analysis-related settings.
Click on System menu > Preference > Video Analysis.

+ Color Settings: Set the color of the image analysis
result overlaid on the image by object type.

- Display Object Type: Displays the object type in the
image analysis result.

- Display Accuracy: Displays the accuracy of the video
analysis results.

- Display Colors: Displays the colors of the video
analysis results.

- Display Event-Triggered Objects Only: Displays only
the event-triggered objects.
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Action

Configure action-related settings.
Click on System menu > Preference > Action.

Fisheye: Set up the default Action when accessing a
fisheye camera.

- Default View Mode: Set the default view mode.
- Image Ratio: Set the image ratio.

- ePTZ Frame Rate: Set the ePTZ frame rate. High
(Over average of 60 Fps), Normal (Over average of 30
Fps), Low (Average of 15 Fps), Very Low (Average of
5 Fps) - a PC with a low specification is appropriate.

- Use ePTZ: Uses ePTZ when accessing a fisheye
camera.
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Save System Menu

Configure still image saving-related settings.
Click on System menu > Preference > Save.

System

Still Image: Set still image related options.
- Folder: Select a folder to save the still image.

- Filename: Set a name of the folder for saving the
still image. Supported extensions include JPG, WebP,
PNG, TIF, BMP and PDF.

- Include Image Information: Include image
information in the saved still image file.

Clip-Copy: Set video related options.

- Use Default File Path: A video is automatically
saved in the pre-set default file path with the default
filename.

- Folder: Set the default folder to use when saving a
video.

- Filename: Set the default filename to use when
saving a video.

- Prompt for Case Number when saving: Displays
the Case Number input window when saving a
video, and the entered Case Number is filled in the
$(CaseNumber).

- Create new folder using Case Number: Displays
the Case Number input window when saving a
video, and a folder of the entered Case Number is
created in the default file path. The video is saved in
the created folder.

Open File: Opens a new file.

Open File Location: Opens the folder where the
currently playing clip file is saved.

Close File: Closes the currently playing clip file.

Split File Playlist: If the currently playing clip file is
a split file, displays a list (playlist) of related playback
files.

Recent Files: Displays recently played clip files (up to
20).

FingerPrint Check: Checks the validity of the entire
section of the clip file.

Export: A collection of tools for exporting data such as
clips, videos, GPS datas, and still images.

Preference: Changes basic settings.

Exit: Exits or restarts the program.
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View + Use Main Hover ToolBar: Sets whether the hover

- toolbar is displayed in the camera pane. When
functions are executed via the context menu, the hover
toolbar is displayed regardless of this setting.

Playback

« Play/Pause: Plays or pauses the currently loaded clip

file.
. Metada Chart: Show/hide the metadata panel, which  Playback Speed: Increases and decreases the playback
visualizes the metadata recorded in the clip file. speed.
« GPS Map: Show/hide the GPS map panel, which - Fast Forward/Backward Play: Plays clip files forward
visualizes the GPS data recorded in the clip fileon a or backward at high speed.

map. « Go to: Skips to the specific point of video to be played.

+ Speed Graph: Show/hide the speed graph panel,

+ Step Playback: Skips to previous or next video by
which graphs the GPS data recorded in the clip file.

frame or time.
« Event: Show/hide the panel, which displays the event
records recorded in the clip file.

« ANPR: Show/hide the ANPR event panel, which is
recorded in the clip file.

+ Autoplay on File Open: When checked, the file will
start playing immediately when opened.

- Repeat Playback: When the playback clip ends, it will
start playing again from the beginning.
+ Reset Window Layout: Resets the layout to its initial

state, doing so will reboot the player.
About

+ Screen Format: Change screen layout.

» Show Previous/Next Group: Switch to previous or
next camera group.

« Show Format 1x1: Shows as a 1x1 format and turn it
off.

+ Select Previous/Next Pane: Select the previous or
next pane.

+ Screen Refresh: Refresh the video in the screen pane - Keyboard Shortcuts: Displays a keyboard shortcut

in the Live or Plays tab.

Screen Magnifier: Magnifies the area near the mouse
cursor.

Pixel Counter: Shows the information of the pixel of
the selected area in Live or Plays.
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description pop-up.

Create a Shortcut: Creates a shortcut icon. It also
displays a popup asking if you want to pin it to the
taskbar, and if you accept, the icon will be pinned to
the taskbar.

Empty Add Cache: Clears all app caches.

About: Shows software version and copyright
information.
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Mobile Player Use

Screen Configuration

On the mobile player, all tabs except for the 'Recorded Video Playback' tab support floating and docking features,
allowing users to freely arrange them for convenience.

You can dock a tab by dragging its header area to the desired location. If it is dropped in a location where docking is
not possible, it will automatically switch to a floating window.

If a tab is closed, it can be reopened from System menu > View.

Playback Screen

The playback screen can be displayed in various layout configurations. Initially, the system automatically detects the
number of cameras and applies the optimal layout to appropriately arrange all video feeds.
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Toolbar

The playback control Ul on the mobile player allows users
to perform a variety of functions as outlined below.

. (Playback Bar): Visually
indicates how much of the video has been played.
Clicking on a specific point moves the playback to the
corresponding time. When hovering the mouse over
the bar, scrolling the wheel allows you to move forward
or backward in time.

. / (Go to Start/Go to End): Moves the playback to
the beginning or the end of the recorded video.

. /  (Pause/Play): Plays or pauses the recorded
video.

. (Time Information [MM:SS]): Displays the current
playback position and the total duration of the clip.
Clicking on the time information allows you to access
the date and time navigation feature.

button returns the vertical indicator to the center and
stops video playback. Clicking the  (Lock) button

and dragging the vertical indicator fixates the vertical
indicator in the new position. Speed control is possible
in lock mode with mouse wheel scroll in shuttle
control.

(Step Playback): Skips to previous or next video
by frame or time. Skip increments can be adjusted
by pressing the arrow between [T] and [[3. Moves
forward/backward in units you set with mouse wheel
scroll in step control.

(Split File Control): This feature is enabled only
when the video has been saved in separate segments.
Hovering over the icon displays button for
navigating to the previous or next file. Clicking it plays
the corresponding file.

(Loop Playback): This is a toggle button for enabling
loop playback. When activated with clicking , the
video will automatically return to the beginning and
play repeatedly after reaching the end.

(Layout):
Changes layout. Various layouts can be selected by
clicking + button. You can switch to previous or next
camera group by clicking ] or [3.

- Entering a specific date and time and clicking Go to
moves the playback to the specified point.

- Load Adjacent Frame: If there is no video at the
selected time, playback jumps to the nearest
available frame.

- Prefer Responsiveness: For Long-GOP videos, instead
of seeking the exact frame corresponding to the
specified time (which may reduce responsiveness),
the system displays the nearest frame to maintain
smoother playback performance.

(Shuttle): Adjusts the playback method
and speed. Jog shuttle's vertical indicator indicates
the current playback direction and speed. Vertical
indicator placement to the right of the center means
the video is being played back in the forward direction.
Placement to the left means the opposite. Farther
away the vertical indicator from the center, faster the
playback speed. Click and drag the vertical indicator
to adjust the playback speed. Releasing the mouse
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In video surveillance, you can quickly control certain
functions without switching modes by combining the
keyboard and mouse. For more details, refer to Smart UX
Quick Control on page 68.



Camera Control

Select a camera screen and place the cursor over the
camera screen to bring up control toolbar. The control
toolbar can be used to control the selected camera.
Place the cursor over each button to view tooltips for the
button. If the control toolbar is downsized, you can move
the toolbar left or right by scrolling the mouse wheel.

. (Fisheye Dewarping): Dewarp the fisheye camera
image.
« @& (Zoom): Zooms the video.

« #) (Color Control) : Adjust the brightness, contrast,
saturation and color of the current video. Click C» to
reset all changes and restore the image to original
settings.

- [ (Image Effect): Applies image effects.
+ (@ (Listen): Receives audio from the device.

Play screen menu

Select a camera screen and right-click to bring up the
screen menu.

- Fisheye Dewarping: Dewarp the fisheye camera
image.

- Image Zoom: Functions identically clicking to the
corresponding buttons in control toolbar.
« Image Processing: Applies image effects.

« VA Overlay: Displays video analysis data over the
monitoring video.

» Aspect Ratio: Sets the aspect ratio of video output.

- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.
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- Fit to Screen(Smart): Resizes video according to the
extra spaces, to the Fit to Screen or Actual Size.

- Fit to Screen(Aspect ratio): Resizes video to camera
screen while maintaining original aspect ratio.

Up, down, left, and right parts of the video may be

cropped depending on size of camera screen. When
using Image Zoom, aspect ratio of camera screen
does not apply and Original Ratio is applied.

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.

- Half Size (x0.5) - 4 Times Bigger (x4): Displays the
camera videos in the selected size based on the
original size of the video.

The menu is activated only when there is sufficient
space to display the camera video in the selected

size.

. Stream Information: Shows the stream information of
the selected camera.

- Still Image: Saves the current frame of the video on
the screen as an image file in actual size.

+ Remove: Terminates connection.

Metadata Chart Panel

Mobile Player supports metadata charts that visualize
metadata stored in recorded videos in the form of graphs,
gauges, indicator lights, and strings by type.

<Chart Toolbar>
The toolbar displays the information of the chart.

+ Chart Name: Displays the name of the chart.

- Data Value: Indicates the data value of the selected
time.

. (Collapse) /
panel.

(Unfold): Collapses/unfolds the site

<Graph Chart>

The data can be illustrated as a line graph (available for
all types except string). The number type is displayed as
a typical line graph, and the boolean and enumeration
types are displayed as a step line graph.
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« Unit: Displays the unit of the y-axis value.

« Marker Line (Dotted): Indicates the playback time of
the image.

» Marker Line (Solid): Hovering the mouse over the
graph displays the corresponding time in a solid line.
Clicking the mouse moves the image to the selected
time.

+ Tooltip: Displays the time and data information which
belongs to the marker line (solid).

<Gauge Chart>
The data can be illustrated as a bar graph (available for
the number type).

« Unit: Displays the unit of the x-axis value.
«+ Tooltip: Displays the time and data information of the
current video playback time.

« Value: Displays the value of the current video playback
time.

<Indicator>
The indicators display on/off status of the data (available
for the boolean type).

+ Tooltip: Displays the time and data information of the
current video playback time.

<Auxiliary String>
Name and value of data is displayed as a string (available
for all types).
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Metadata Settings

Configure the metadata popup and chart settings. The
settings are applied to all of the metadata popups for
IDIS Center.

<General>

+ Use Accelerometer: Select to use an accelerometer in
a metadata chart.

+ Use Voltage/Temperature: Select to use a voltage/
temperature in a metadata chart.

+ Use UPS Status: Display UPS Status data in JSON
format in a metadata chart.

+ Metadata Chart Auto Popup: A metadata chart
window automatically pops up when connecting to
a device which includes metadata. (This is supported
only for IDIS Center)

« GPS Map Auto Popup: A GPS map window
automatically pops up when connecting to a device
which includes GPS data. (This is supported only for
IDIS Center)

- Speed Graph Auto Popup: A speed graph window
automatically pops up when connecting to a device
which includes speed data. (This is supported only for
IDIS Center)

<Metadata>

A metadata chart window automatically pops up when
connecting to a device which includes metadata. Click
the  button and use the mouse wheel or up/down
arrow buttons on the keyboard to change the order.



. (Add): Adds a metadata item.

. (Delete): Deletes a metadata item.
. (Edit): Edits information of a metadata item.
. (Import Saved File): Imports a file with the saved

metadata item and applies to the item list.

. (Save as File): Saves a metadata item information
as a JSON (json) file.

<Add/Modify Metadata>

- Identifier: Distinguishes the metadata.
- Name: Displayed on the toolbar of the metadata chart.

« Type: Displays the type of the metadata value
(Boolean, String, Numeric, Numeration).

- Display Type: Displays the type of the metadata chart
(Graph, Gauge, Indicator, String).

» Use Line Graph: Displays the data as a line graph.

« Unit: Select the unit of the metadata. Selecting Custom
allows you to manually enter the unit.

+ Color: Select colors for graph, gauge and indicator
using the color picker.

- Use Default Color: Uses the default color without
selecting a color in particular.
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- Duration Time: Used for the string type. Select the
duration time of string.

« Infinite: Set the string duration time as infinite.
The string is displayed until the next string data is
displayed.

+ Min Value/Max Value: Used for graph and gauge type.
Select the minimum/maximum value of the graph.

+ Item: Used for enumeration type. Enter name and
value to define the item. Click ~ (Add),  (Delete),
(Edit) buttons to apply the enumeration items to
the list.

GPS Map Panel

Mobile Player displays the vehicle location and travel
route from recorded video GPS information and supports
functions supported by Google Maps (street view,
satellite map, etc.).

+ You can turn it on and off from System menu > View.

+ Clicking on a path or dragging and dropping a marker
on the path will move to the point corresponding to
the location.

Speed Graph Panel

Mobile Player supports speed graphs that visualize
latitude, longitude information and vehicle speed
contained in recorded video GPS information.

+ You can turn it on and off from System menu > View.

« Get GPS information by load balancing based on the
current time.
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» Hovering the mouse, you can see detailed speed
information as a tooltip, and when you click, you can
move to the corresponding time.

You can set options related to Speed Graph through the
context menu when you right-click the mouse.

« Graph Type: Change the graph type to Consecutive

Line, Consecutive Curve, Staraight Line, and Bar Graph.

«+ Graph Unit: Set the speed unit. (Kilometers/hr, Miles/hr)

+ GPS Info: Turn on/off GPS time/latitude/longitude
information.

« Refresh: Refresh the speed graph.

Event Panel

Mobile Player supports an event panel that displays
event records contained in recorded video in list format.

+ You can turn it on and off from System menu > View.

. : Filter events by entering keywords
corresponding to the event/device/data.

+ Clicking an event goes to that point in time.

. : Move to the next/previous page by
pressing  or
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+ You can also easily navigate between pages using the
overlay window that appears when you click

ANPR Event Panel

Mobile Player supports ANPR event panel that displays
ANPR records contained in recorded video in list format.
It can be turned on and off from System menu > View.

. : Search for events by entering keywords
corresponding to license plate / lane / device / data.

+ Clicking the ANPR event goes to that point in time.

. : Move to the next/previous page by
pressing or

+ You can also easily navigate between pages using the
overlay window that appears when you click



Export Clip-Copy

Saves video recording as a clip-copy file. Click System
menu > Export > Export Clip-Copy.

From, To: Enter the date and time of the recording you
wish to save as video.

- First: Sets date and time of the first video as the start
point.

- Last: Sets date and time of the last video as the end
point.

- %1 Minute, £3 Minutes, £10 Minutes, £30
Minutes, £1 Hour: Adds or subtracts the amount
of time from the time currently selected on the
timetable.

Camera: Select the camera to save recorded video.

Save Password: Set a password for playing the video.
When a password is set, the viewer program asks for
password while running.

Include Digital Signed Player: Includes digital signed
player to play recorded clip.

Include OSD Watermark: Saves the specified
watermark(text or text pattern) with the video.
Exclude Player: Saves only the video recording
without mobile player.
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Export Video

Saves video recording as AVI file(.avi). Click System menu
> Export > Export Video.

From, To: Enter the date and time of the recording you
wish to save as video.

- First: Sets date and time of the first video as the start
point.

- Last: Sets date and time of the last video as the end
point.

- %1 Minute, 3 Minutes, £10 Minutes, 30 Minutes,
+1 Hour: Adds or subtracts the amount of time from
the time currently selected on the timetable.

Camera: Select the camera to save recorded video.

Codec, Bitrate, Quality: Set the appropriate value for
video compression.

- Encoding Based on Bitrate: Encodes video based
on bitrate.

- Encoding Based on Video Quality: Encodes video
based on video quality.

Size: Set the file size for the compressed video, then

select aspect ratio.

- Original Ratio: Resizes camera screen to original
aspect ratio of the video.

- Fit to Screen: Resizes video to camera screen
regardless of original aspect ratio.

- Fit to Screen(Aspect ratio): Resizes video to camera

screen while maintaining original aspect ratio. 157
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Up, down, left, and right parts of the video may be

cropped depending on size of camera screen. When
using Image Zoom, aspect ratio of camera screen
does not apply and Original Ratio is applied.

« Anti-Aliasing: Removes stair step effect (blocks) that
are caused when zooming a video to improve overall
quality of video output.

- Keyframe: Set the interval of key frames for video
compression.

« Max File Size: Set the maximum size of the file.

« Fisheye Dewarping: Saves the video as dewarped
image displayed on the screen. This function is
only activated in a single camera with the activated
dewarping function. The video can be saved in
panoramic or VR mode.

+ Include Audio Data, NVR Audio Included: Only a
single channel is supported if the video was saved with
audio.

If the video is recorded at a size smaller than Tips,
saving audio may not be successful.

+ Save Split File: If the file size of the saved recording
exceeds Max File Size, the video is saved into multiple
files while not exceeding the maximum file size.

If Save Split File is not enabled, output file will be
limited to the maximum file size.

« Include OSD Watermark: Saves the specified
watermark(text or text pattern) with the video.

+ View Proceeding Frames: Shows the current frame
being saved in a popup screen while saving.
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Exit Program

When you exit the Mobile Player, a confirmation message
pops up.

If you check Don't pop up the current message when
the close button is executed and then exit, the message
pop-up will not appear when you exit from the next time.
To disable this setting, click System menu > Exit... and
uncheck the option.

V6.8
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